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Welcome From The Editor
Welcome to the September, 2009 issue of the NEW
PCLinuxOS Magazine. For me, personally, it has been
a very busy past month. I learned Scribus – at least I
have enough of a handle on it to assist with the
magazine's layout.
But enough about me. This month we have lots of
material that should appeal to a large section of the
PCLinuxOS community. In his continuation of his series
of articles, Patrick G. Horneker reviews photo
management software in his Through The Lens
article. Andrew Huff compares Windows 7 and KDE
4.3, and gives us a peek at how well PCLinuxOS runs
on his Acer Aspire One netbook. From the
PCLinuxOS Gnome forum, David Lally walks us, step
by step, through setting up Samba file sharing the
easy way. In the second installment of Behind The
Scenes, we get to learn more about Neal Brooks and
how he met the challenge of creating PCLXDE, the
PCLinuxOS LXDE remaster.
Don Crissti, from the PCLinuxOS Gnome camp, gives
us the second Scripts-R-Us column, with a script to
test the speed of the various PCLinuxOS repositories.
Ms_meme turns her Forum Foibles attention to
exploring some of the more interesting forum members'
signatures, as well as offering up yet another reworked
musical piece in ms_meme's nook. We get to learn
the easy way to share a printer connected to a
PCLinuxOS computer with Windows without Samba, in
the Wiki Wicket. There's a short, yet informative, article
on how to use openssl to create secure, random
passwords. Malcolm Ripley shows us how to make an
inexpensive, home made film scanner from parts you

may just have lying around. Malcolm also walks us
through the use of dvd::rip to create archives of
your home DVD collection.
I complete my
series of articles
on file format
comparisons,
taking a look at
video file
formats this
month. I have
also written an
article on the
grand daddy of
all Internet chat
software, called
IRC: The
Forgotten Chat
Frontier, and
walk you through
setting up XChat
so you can join in
on the fun there.
Gary Ratliff, Sr. is
back, and
continues his series of articles on computer
programming languages, in Computer Languages A
to Z: C/C++. Plus, Mark Szorady provides us with
another installment of Double Take, along with a GIMP
tip on how to work with layers.
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Welcome From The Editor
We, the magazine staff, hope you enjoy this new issue
of the NEW PCLinuxOS Magazine. This month's cover
is by Timeth, winner of the PCLinuxOS Mascot
competition with his entry of "Dobie the Bull," and
commemorates that "Back To School" time of year.
To the magazine staff and all who have contributed to
this month's issue, I'd like to send out a huge thank you.
And, to the PCLinuxOS community, thanks for giving us
the audience with your readership, and thank you to
every member of the PCLinuxOS community for your
contributions in making this one of the best – if not the
best – Linux distribution around.
Paul Arnote [parnote]
PCLinuxOS Magazine Chief Editor
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KDE
KDE 4.3
4.3 and
and Windows
Windows 7
7 Comparison
Comparison
by Andrew Huff (athaki)
Today I'm comparing the interfaces for Windows 7 and
KDE 4.3, making note of how they compare, differ and
which one is best for 'Joe User'.

Windows 7
I'll start with Windows 7, which is one of the most
anticipated releases for the Microsoft camp ever
(especially due to the numerous bad reviews of Vista).

Windows 7 comes in six different versions, three of
which will be available to the consumer at retail:
Windows 7 Home Premium, Professional and Ultimate.
Windows 7 Starter is targeting installation on netbooks,
while Windows Home Basic is intended for sale only in
emerging markets. The sixth
version, Windows 7 Enterprise,
falls right below Windows
Ultimate, and is intended for
volume licensing.
Most users will go for the
Home Premium edition, unless
they are looking for specific
business-related features of
Windows 7 such as:
connecting to a domain,
operating as a Remote
Desktop server, file system
encryption, presentation mode
and Windows XP mode
(requires an additional 1 GB of
memory, 15 GB hard drive
space, and a processor
capable of hardware
virtualization). Windows 7
Ultimate will not have any of
the 'Ultimate Extras' that Vista
had.
In the end, if you're just going to be doing basic word
processing, listening to music, watching DVD/Blue

5

KDE 4.3 and Windows 7 Comparison
Ray/Video files and surfing the internet, Windows 7
Home Premium will be the one best suited.
Windows 7 does have a smaller initial memory
footprint, and programs feel a little snappier than on
Vista, but in my experience the differences were
negligible from when I used Vista. User Account
Control does seem less 'in your face' than in Vista.
However, I'm personally so used to it that it's difficult for
me to determine when it's not notifying me about
something. In the interface department, the taskbar is
larger (reminiscent of KDE) and when one right-clicks,
one gets this nice menu:

This is nice, but how many average people would
actually right click on a taskbar icon? The start menu is
not too different from Vista, but it does make 'shutdown'
the default option.
The ribbon interface has also been incorporated into
Wordpad and Paint (screen shot on the following page).
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Windows 7 also includes something called 'Libraries',
which combines folders of your choosing into one
window. For example, the documents library includes
the folders 'My Documents' and 'Public Documents.'
One can add folders to the default libraries (Documents, Pictures, Videos and Music) or create their own.
PCLinuxOS KDE 4.3
In the PCLinuxOS version of KDE 4.3, the PC menu
remains mostly similar to the KDE 3.5.10 version.
However, the 'factory shipped' version of KDE 4.3
comes with an empty desktop, which is similar to the
default desktop of Ubuntu. KDE 4.3 has a dedicated
taskbar button for any media that could be inserted into
the computer. This ranges from DVD and CDs to flash
media and camera cards.

Another aspect is the folder preview option when one
hovers over a folder on the desktop:
Memory use on
KDE 4.3 seems
rather efficient.
On my 2GB
RAM machine,
KDE 4 is using
221MB with
Firefox open,
which could
mean that it
could be installed successfully on computers with
256MB of RAM. Windows 7, on the other hand, has a
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minimum memory requirement of 1 GB. The biggest
difference for users switching from KDE 3.5 to KDE 4.3
would be getting used to the new file manager, Dolphin.

$199.99 US for the upgrade, and $299.99 US for the
full retail version. If you opt for Windows 7 Ultimate, the
upgrade version will cost $219.99 US, and the full retail
version will run you $319.99 US. Microsoft has offered
heavily discounted "pre-orders" of Windows 7 Upgrade,
allowing Windows XP and Windows Vista users to
upgrade to Windows 7 Home Premium for $49.99 US,
and to Windows 7 Professional for only $99.99 US.
It's also important to keep in mind that these prices
reflect only the price of the operating system. Under a
Windows operating system, you still have to pay for the
applications that make you productive. Running
PCLinuxOS on your computer gives you not only the
operating system free of charge, but also free access to
all of the more than 11,000 programs in the PCLinuxOS
repository.

The interface is very intuitive and straightforward. It
shouldn't be too big of a problem for new users to use.
So, which version should 'Joe User' install? As stated
above, if they're just doing basic tasks, Windows 7
Home Premium would fit their bill. However, as we all
know, PCLinuxOS is more than capable of doing those
same tasks as well. PCLinuxOS also has the good
fortune of being 'gratis', whereas one would have to pay
at least $119.99 US to acquire an upgrade license for
Windows 7.
The full retail version of Windows 7 Home Premium will
set you back $199.99 US. Windows 7 Professional
(equivalent to the Vista Business Edition) will cost

Aside from the cost, Windows 7 has much "loftier"
hardware requirements. The 32-bit version of Windows
7 requires 1 GB of memory, a video card with a
minimum of 128 MB of memory, and 16 GB of hard
drive space. The 64-bit version of Windows 7 requires
double the memory (2 GB) and 20 GB of hard drive
space. Contrast this to KDE 4.3, which requires only 4
GB of hard drive space, and will run on a computer with
as little as 256 MB of memory, although 512 MB of
memory and 10 GB of hard drive space are
recommended.
So there you have it – a comparison of KDE 4.3 and
Windows 7. Where do you want to go today?
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PCLinuxOS
PCLinuxOS Wiki
Wiki Wicket
Wicket
Sharing A Printer To Windows ...
WITHOUT SAMBA
The PCLinuxOS Wiki is currently undergoing a "fromthe-ground-up" reorganization and rebuild, and they are
seeking members of the community to assist with the
task. If you would like to help, go on over to the Wiki
site and sign up! Meanwhile, during this rebuilding
period, I'd like to share one of my favorite Wiki finds
from the "old Wiki," that I saved from digital oblivion
some time ago that works exceptionally well with the
current version of PCLinuxOS. - Paul Arnote,
PCLinuxOS Magazine Chief Editor
Sharing a printer with a Windows box usually requires
Samba. In this tutorial, I will show you how to do it,
without.

5. Click Add, and set the type to Allow. Enter the range
of your network computers. You can enter a wildcard
mask into the first box, like 192.168.1.*.
6. Go to Print Server » Restart print server to restart
everything and apply your new changes.
On your Windows clients
1. Control Panel » Printers and Faxes » Add Printer »
Network Printer
2. Enter the url as
http://yourprintserversname:631/printers/printername.

On your PCLinuxOS Print Server

"yourprintserversname" is the address of the computer
your printer is attached to (e.g., 192.168.1.100).
"printername" is the name you call the printer in CUPS
(e.g., HP_LASERJET_P1006).

1. Install your printer normally, using the PCLinuxOS
Control Center.

You should now have a wonderful Samba-less printer
now!

2. Make sure CUPS in PCC » System » Configure
system services is set to start on boot.

I do not know who the original author is, but this has
made my life very easy, allowing me to set up my wife's
WinXP laptop to be able to print to my HP LaserJet
P1006, attached to my PCLinuxOS desktop system.
And it works perfectly, every time.

3. Open the KDE Control Center, and browse for
Peripherals » Printers.
4. Activate Administrator Mode, and go to Print Server »
Configure Print Server » Browsing » Browsing
Addresses.

One consideration to make is to make the IP address of
the computer that has the printer attached a static IP
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address. This way, the address doesn't change or get
reassigned by the router.
Do you have a favorite tip, trick, or technique that
belongs in the Wiki? Do you have a favorite Wiki "find"

that has saved you time and work? If so, send them
along to the PCLinuxOS Magazine staff. The
"PCLinuxOS Wiki Wicket" is planned as a regular
feature of the PCLinuxOS Magazine, featuring a new
item from the PCLinuxOS Wiki in each issue.

Create Secure Passwords With openssl
If you have ever had to attempt to create a secure
password, you may have undoubtedly tried to join
together phrases, words and numbers in a seemingly
random manner. We've all done it. But did you know
that the ability to create secure passwords is no further
away than the command line?

So then, what do we do if we want to generate a
random 25 character string to use as a WPA key? We
will have to chop it off ourselves. Enter the following at
the command line prompt in terminal:

Enter the following at a command line prompt in
terminal:

Be sure to record your newly generated password in a
secure place, should you ever forget it. With the
number of possibilities, it's astronomically unlikely that
you will generate the same password again.

openssl rand -base64 6
This will create an eight character password, comprised
of 6 random bits of base64-encoded data. Would you
like a randomly generated 16 character password?
Enter the following at the command line prompt in
terminal:
openssl rand -base64 12
When we send random data through the base64
encoding process, the output string length will always
be a multiple of four. If there isn't enough random data,
"=" will be added to the end of the string to pad it out
until the string length is a multiple of four.

openssl rand -base64 25 | cut -c1-25

You may also add redirection to the end of the above
commands, to save your new password into a file,
which can (should) be moved to a secure folder on your
computer.
For example, openssl rand -base64 6 >pass8
will save the generated password into a file, named
"pass8." You can name the file whatever you like -- just
be sure to move it to the secure folder, to keep it from
"prying eyes." After all, there is nothing quite like
forgetting your old passwords.
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Through
Through The
The Lens:
Lens:

Photo
Photo Management
Management Software
Software

by Patrick G Horneker
If you are like me and have a large collection of
photographs, you will need software to organize your
collections. PCLinuxOS has several pieces of software
to accomplish this task. The two most popular
packages in this category are DigiKam for KDE, and FSpot for GNOME. There are more software packages
that can be installed from Synpatic such as Google
Picasa, flphoto, and feh. In addition, if you have Wine
installed, you can install some photo management
software packages for Windows provided by various

photofinishers on CD-Rs that you get with film
photofinishing orders.
DigiKam
This is my absolute favorite photo management
application, and it is a part of PCLinuxOS 2009.1 KDE
edition. (If you are not running the KDE edition of
PCLinuxOS, you will need to launch Synaptic, then
download and install the digikam package. The
package is found in the Graphics section.)
If you have upgraded to
KDE4 by installing the
task-kde4 package, you
will need to reinstall
DigiKam as the older
KDE3 application was
removed at the time of
upgrading. The KDE4
version of DigiKam is
now in the Graphics
Desktop/KDE4 section.
Note: Though DigiKam
was designed to be used
with KDE, it can run
under any window
manager. If you choose
to run DigiKam outside of
KDE, keep in mind that

DigiKam on KDE 3.5.10
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the basic KDE libraries will need to load before
DigiKam is launched, hence increasing the time needed
for DigiKam to load.
When you launch DigiKam the first time, you will be
asked for a directory where your photograph collection
is stored. By default, it is the Pictures directory in your
home directory, for example /home/patrick/Pictures on
my laptop. DigiKam will then build a database of
thumbnails for each photograph you have in that
directory, and any subdirectories contained within that
directory. Next, a set of plugins will load providing the
many great features of this photo management
application. Finally, the main application window opens
up as shown here.

What you see here is toolbars at each edge of the
application window, then a layout similar to what you
would find in Nautilus or Konqueror (running as a file
manager rather than a web browser). In fact, DigiKam
is really a the Konqueror browser adapted for photo
management.
The version I am running is Version 1.0.0 of DigiKam
for KDE4. The Tip of the Day window appears on the
screen, and the home directory appears in the sidebar
instead of the Pictures directory as in the KDE3 version.
When you click on a folder, a dynamically generated
HTML page containing the thumbnails of photographs
in that folder appears in the window.
This example shows images taken
with my Cybershot DSC-H10 camera.
(The EasyShare C300, hpm22 and
Cobra8MP refers to the Kodak
EasyShare C300, Hewlett-Packard
PhotoSmart M22, and the Cobra 8
Megapixel cameras.)
Note: In the case of the Cobra, this
was known as the Black Friday
special, as it was typically available as
a big bargain on Black Friday, the
largest sales day of any retail
business in the US, and is always the
day after Thanksgiving. Black Friday

DigiKam on KDE 4.3
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is the official beginning of the holiday season in the
retail business, and massive crowds build up at stores
nationwide as early as two in the morning on that day to
get the best bargains at the start of the holiday
shopping season.
Cameras like these are typical bargains at that time of
the year.
What's New with the KDE4 version of DigiKam
Version 1.0.0 now shows a filmstrip inside the
application window below the image that you wish to
see a larger view. This allows you to scroll through
your photographs without having to return to the
multiple thumbnail view first to look at the next
photograph. This feature was first implemented with FSpot, which will be discussed next.
You can put on a slideshow this way, and there is a new
toolbar under the application menu that allows for this
to happen.
In the last issue, I discussed the Kooka scanning
application. From the Import menu, you can launch
Kooka to scan images directly to DigiKam. The menu
also allows you to import images from any camera
supported by the gphoto suite. If your camera
communicates with your PCLinuxOS machine as a
USB Mass Storage device, that device will
automatically appear in the Import menu.
The Export menu allows you to create CD or DVD
archives of your photograph collection, create web

galleries of your photographs, export to Flickr or
PicasaWeb, or simply copy images to another directory
on your hard drive for further processing.
F-Spot
This is the other major photo management application
for PCLinuxOS. This application is included with
PCLinuxOS GNOME edition. If you are running any
other edition of PCLinuxOS, you will need to launch
Synpatic and download f-spot from the Graphics
section. Since this application was written in C#, the
Mono project and its dependencies will also be
installed, and hence this will be a lengthy download
(unless you have a really fast broadband connection to
the Internet).
F-Spot was written for the GNOME desktop and runs
best under GNOME. When you first run F-Spot, you
will be prompted to select a directory where your
photographs are stored.
F-Spot stores its database in Photos on your home
directory. If you store your collection in the Pictures
directory as I do, you would want to click on Select
Folder, then choose Pictures, click on OK, and your
pictures will be imported to F-Spot.
When F-Spot is finished, you will see thumbnails of the
images that have been imported. Click on Import to
build the database.
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drag out the sidebar.
F-Spot provides a timeline
and a search bar. The
sidebar works after your
photographs have been
tagged. The sidebar
provides the tags you can
use, or you can create your
own tags.
The easiest way to tag
photographs is to select
images, right click on the
selection, then select the
tags you want from the
popup menu.

F-Spot on PCLinuxOS Gnome 2009

There is a sidebar in the
application. To access
this, move the mouse to
the left side of the
application window, with
the mouse pointer inside
the window, wait for the
cursor to change to
horizontal arrows, then

Once images have been
tagged, you can then drag
the tags from the sidebar to
the search bar to display only images that have been
tagged with the tag you have dragged to the search bar.
Like DigiKam, F-Spot has export options that allow you
to create web galleries and post to Flickr. Unlike
DigiKam, the tagging system is more suitable to
photograph organization. F-Spot also has version
tracking, where if you modify the image in any way with
F-Spot, you can save and recall multiple versions of the
same image.
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Google Picasa
This is Google's
software
package for
organizing of
photographs,
and was
designed to be
used with
PicasaWeb,
Google's photo
sharing service.
You can install
this package
from Synaptic.
It can be found
under the
Applications/Gra
phics section.

Google Picasa Folder Manager

When you first
run Picasa, it will
start scanning
the entire
contents of your
home directory.
This means all
of your
documents,
music files, downloads, and everything else will be
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scanned for graphic files. To ensure that only the
directories where your photographs are scanned, select
Folder Manager from the Tools menu.
It is here where you select all folders containing your
photograph collection. I suggest first, select your home
directory (for example /home/patrick on my laptop),
then click on Remove from Picasa. You will be asked if
you really want to remove the contents of that directory
from Picasa's repository. Click on Yes to confirm
because we want to include only the images that are in
our directories that contain photographs.
At this point, we have cleared out the Picasa repository.
Now we are ready to select folders that contain only
photographs.
On my laptop, I have my collection stored in
/home/patrick/Pictures. This is the same folder I use for
DigiKam (which happens to be the default folder used
by DigiKam). So I them expand the folder listing and
select Pictures. Then I click on Scan Always to tell
Picasa to only look in this folder and to traverse all
folders contained within Pictures.
Now click on OK and Picasa will scan only the folders
we want.
Google Picasa 3 running on PCLinuxOS
Like DigiKam, you get a listing of folders on the left
sidebar, and the thumbnails of all the images your
collection. As you scroll up and down the thumbnail,
the header changes showing which folder you are now

viewing.
In this example, the folder containing my scanned
images taken in Las Vegas has been selected. At the
bottom of the application window, you will see a number
of icons representing what you can do with the selected
images.
Here you can upload these to PicasaWeb, e-mail them,
print them, export them to another folder, order gift
items made from these images, blog about them at
Blogger.com, make a collage, or create a slideshow (in
MPEG format).
PicasaWeb
You can use this application by itself, as with DigiKam
and F-Spot. However, to get the real power of the
application, you will need to login to PicasaWeb. (You
can use your existing Google account to do this, or sign
up at any Google website to get an account.)
Once you have a Google account, you will then need to
upload images to PicasaWeb. Simply select which
images you want to upload, then click on Upload at the
bottom of the application window. I suggest selecting
folders on the lest sidebar as the names of the folders
will be used to create new folders at PicasaWeb. Once
you click on Upload, you will be prompted to login with
your Google account before the uploading process
begins.
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Once you start uploading your images, a window will
open showing the progress of your uploads. You will
want to click on the checkbox labelled Don't eat all my
bandwidth, especially if you want to do other things
while your photographs are being uploaded.

Ordering screen on Picasa 3

Once you have your photographs uploaded to
PicasaWeb, you will be able to share them and order
prints and gifts made from them.
Note: You can also use DigiKam with PicasaWeb.
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While running DigiKam, select Export to Picasaweb
from the Export menu.
Setup Picasa to Enable Ordering
There is a bug in the current version of Picasa that
prevents you from accessing the online shop. The
solution to this problem can be found at the support
forum for the Picasa package. To fix this, you will need
to login as root (to be able to make changes to the file
not in the user account), open a text editor and load this
file:
/opt/google/picasa/3.0/wine/drive_c/Program\
Files/Google/Picasa3/runtime/defaults.ini
(You may or may not need to include the backslash
depending on which editor you use to open this file.)
then you will need to change the line containing
printerURL, which is showing an incorrect URL,
resulting in a blank window opening up instead of the
photo ordering page. The corrected defaults.ini should
read as follows:
[LifeScapeUpdater]
versionFileURL=http://updates.picasasoftware.com/pica
sa2/wine/currentversion.ini
readmeURL=http://readme.picasa.com/wine/
printerURL=https://client4.google.com/providers/printers
.html
[Track]
name=wine

The highlighted line shows the correct URL for ordering
of prints from your photographs. Once this is fixed,
clicking on Shop will yield the screen on the previous
page.
Note that you really have freedom of choice here.
There are sixteen different vendors for which you can
submit print orders. Walgreens and CVS are two of
those choices, and they provide their own ordering
software in addition to what you can order from Picasa.
Note on Photofinishing Retailers
Walgreens, CVS, and Wal-Mart allow you to order
online and then pick up your prints at a nearby store in
one hour. This of course, brings out the utmost
convenience when it comes to digital photography,
provided that you have a store nearby where you live.
W Photo Studio (Walgreens)
This photo management is a Windows application that
runs on PCLinuxOS with Wine installed, and was
designed to be used with the WPhoto.com
photofinishing services. (WPhoto.com is a microsite for
the Walgreens drug store chain providing digital
photofinishing services.)
There are two ways to get this software. The first is to
order a CD-R for a nominal fee added to your film

18

Through The Lens: Photo Management Software
photofinishing order. The second is to download the
software from Wphoto.com.

This is a 84.7MB download, so a fast internet
connection is recommended.

WPhoto running in Wine on PCLinuxOS

If you do not have Wine installed, you will need to
launch Synaptic and download wine-dev (and its

I recommend downloading from Wphoto.com to be sure
you get the latest version of W Photo Studio.
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dependencies) from the Emulators section. The winedev package contains the latest version of Wine.

If you are installing from a CD-R you received with your
film photofinishing order, you will need to double click
on photoappsetup.exe to
install W Photo Studio.
Just follow the instructions on
the installer, agree to the
license agreement (this is not
free software), and let the
installer do the work. An icon
will appear on your desktop (if
you are running KDE or
GNOME), and you will be
able to launch W Photo
Studio from PCLinuxOS.

The WPhoto software installer in Konqueror
If you downloaded the package, create an empty
directory (or use a directory you allocated for
downloads) and drag the downloaded file to that
directory, then double click on Wphoto_Studio.exe to
lanch the installer.

When you launch W Photo
Studio, the screen here is
what you will see. As this is a
Windows application not all
functionality is guaranteed
under PCLinuxOS. This
depends upon the current
functionality of the Wine
package. On my PCLinuxOS
machine, I have the latest version of Wine installed.
W Photo Studio comes with some specialized DLL files
(Windows libraries) that launch Internet Explorer and
take you to WPhoto.com. Since we are running this on
PCLinuxOS, the four options that are shown on the
screen may not work as the Internet Explorer
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functionality implemented with Wine does not support
the specialized DLL files.
However, the Photo Organizer near the bottom of this
window does function as expected. This button
launches the actual photograph organizing application.

When you launch Photo Organizer for the first time, it
will attempt to search your hard drive for photographs.
The drive letter used depends upon how you
configured Wine. On my PCLinuxOS system, Photo
Organizer uses drive E, which is configured to use my
home directory.

WPhoto Welcome screen on PCLinuxOS
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Since Windows applications were designed to work
with the NTFS, FAT16 and FAT32 file systems, of
course it will crash when it comes across the ext3, ext4
or other non-Microsoft file system. To prevent this, click
on Stop Search to close the window.
The screen you see here is what you get upon first
launch.
Click on Switch to Folders View to access your home
directory. The gallery you see will update to display all
images found in the current directory.

If you have ever been in a Walgreens drug store in the
US, this software has the same functionality as the
WPhoto kiosks in their photofinishing department.
Now the bad news. The online functionality relies on
specialized DLL files, which may or may not work with
the current version of WINE that comes with
PCLinuxOS. To this date, I have not tested this
functionality.
To get around this, you can launch any web browser,
and log in to WPhoto.com. There you can upload your
photographs, select
your images to order
and place your order
there.
In short, W Photo Studio
is a rudimentary
program for
organization of
photographs, but not
much else. You would
be better off using a
native Linux package
such as DigiKam or FSpot, then launching a
web browser to upload
and order printed
photographs from your
favorite photofinisher.

WPhoto Photo Gallery screen
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Walgreens provides an online version of the software
where you can organize your photographs, and you can
use Firefox, Opera, or other compatible browser from
PCLinuxOS.
CVS/Caremark
Rival chain CVS Pharmacy provides a online storage
and photo organzation tool on their photofinishing
microsite. Their software package is a branded version
of Corel Photo Album, with functionality for uploading to
their microsite.

division of Hewlett-Packard. Their stores feature kiosks
equipped with Hewlett-Packard hardware, including a
ScanJet scanner. Snapfish has online photograph
storage and organization. Fortunately, for us
PCLinuxOS users, according to Snapfish, you can use
Firefox to upload photographs to the Snapfish site,
despite the fact that only Internet Explorer is mentioned
in their FAQ list.

Corel Photo Album 6
I got a copy of Corel Photo Album 6 when I purchased
a Lexar memory card for my Cybershot. I decided to
give this package a try. The installer launches, but I
was unable to get past the License Agreement as that
part of the installer would not let me click on the Next
button after I scrolled down to the bottom of the License
Agreement. I am not sure if this is a bug in Wine or a
bug in the installer. Since I was not able to get past this
screen, I cannot say whether this application will work
on PCLinuxOS or not.
Meijer Photo/Snapfish
Meijer has been one of my favorite places to shop
offline for most anything. Their digital photofinishing
services utilizes Snapfish, the digital photofinishing
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Easy
Easy Samba
Samba File
File Sharing
Sharing Set
Set Up
Up
by David Lilly (sarcastic_bastard on linuxgator.org)
Ok, we seem to have a few people asking this one, and
rather than me keep repeating it (even I get tired of
repeating the same thing 300 times), I figured it might
be an idea to throw up something a little straight
forward for you lot. This method will enable you to set
up Samba Shares (similar to windows file-sharing over
a network) without needing to use passwords. But
there's nothing stopping you setting it up with
passwords either. It's just that I'm sure most folk would
like simple file-sharing enabled in their home network,
for ease of use. Either way, the basics are the same.
Now, I've found myself doing this in 2 slightly different
methods before in the past, both achieving the same
result. But one requires an extra step, but for a reason.
Bear with me here.
It's a good idea to make sure all needed Samba
packages are installed first, so open up Synaptic (your
package manager), and ensure Samba Client and
Samba Server are installed.
Now, the straight-forward method is as follows. Go up
top to System, then Administration , then Configure
Your Computer (PCLinuxOS Control Center). I usually
select to "Add This Launcher to panel", since it saves
time later when you want it. In here, select Network
and Internet, then Manage Hosts Definitions. By
default, mine (and yours) will show an IP Address of
127.0.0.1, and a hostname of localhost. This always
gave me grief when trying to set up Samba, until i
worked out I needed to change this. Either double-click

on the line with 127.0.0.1, or click on it and select
Modify on the right. Same result either way. Leave the
IP Address bit alone, but where it says Host Name,
change it to something you would like your PC to be
seen as on the Network (there's a little more to it, but
this is just simpler), such as Bob, Truck, Matt's PC, etc.
Give it a distinctive name. This is what it will show up as
on the network when connected and sharing with other
PCs. Mine is named Xero. Then, when you've done
that, and before closing it off, write "localhost" in the line
below, where it says "host aliases". Click OK, and now
you will see your PC with it's new name, and localhost
off to the right where there was nothing. Click OK at the
bottom again, and close off so that you are back at the
PCLinuxOS Control Center again.
Down the left hand side again, choose Sharing from
the top, then Set Up A File And Print Server. If Samba
is not already installed it will prompt to, and install itself.
Next, it will walk you through the configuration. Unless
you need something more than basic, such as working
with a domain (which i know nothing about anyway, so
we'll leave that), choose Standalone at the bottom, and
click next.
Now, you need to select the Workgroup name. All the
PCs in the network must share the same workgroup to
see each other properly. By default, Microsoft OS's
usually choose either MSHOME or WORKGROUP as
the workgroup, so if you are expecting to connect with
Windows PCs now, or later, this is where to change it. If
all the PCs are just running PCLinuxOS, or Mandriva
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for that matter, the default of MDKGROUP should
suffice, but you can also change it to something else,
such as WORKGROUP, or PEACH, or whatever you
like really. But all the PC's will need to use the same
workgroup name. That is all you need to really worry
about.
The line under that says NetbiosName, and you can
either add your PC's name (eg. Xero) there, or change
it to something else you might want it seen as on the
network, or, since we've already named it previously,
you can just leave it blank, and it should default to the
name you gave it previously. You really don't "need" to
fill this in as your PC already has a name, but it if you
prefer, or want it to be seen on the network as
something other than what we named it before.
You can basically click next all the rest of the way thru
this, til it's done. Any basic network will be satisfied with
the defaults, and you'll be told you've "Successfully
Configured your Samba Server", at which point you can
click Finish at the bottom right, and it should close off,
leaving you back at the PCLinuxOS Control Center.
Now, you should (in the PCLinuxOS Control Center) go
to Mount Points, and select Set up Sharing of your
Hard disk partitions. Here it will ask how you how you
want to setup allow users to share directories. You can
set it so no-one can share (defeating the entire purpose
of this), allow everyone (allowing all users to share
folders as they wish to define), or Custom (allowing you
to setup custom permissions, as to who can share, and
what). For a simple home-network, I suggest just
choosing "Allow all users," hit OK at the bottom right,

and making sure SMB is selected, then hit OK again.
You'll find yourself back in PCLinuxOS Control Center
(again).
Now that the Samba server is set up, and configured,
all that is left to do is to define our "shares". There is
basically 2 ways I can suggest to you (as these are how
i have successfully done mine before). I should point
out that I have my OS's (XP, and PCLinuxOS Gnome,
with XP not being booted in months) on my first primary
drive, and I have 2 other drives I use for storage. Both
are formatted as ext3, but if yours are formatted as
FAT32 or NTFS, it should make no difference. You may
need to allow or set up write access to the NTFS
partitions, but reading from them should be fine either
way.
With my drives set up as they are, I can either set up
shares through the PCLinuxOS Control Center, under
Manage Configuration of Samba, or I can use the "rightclick" option when clicking on folders, and choosing
"Share." This second option will only work for folders in
your /HOME/USERNAME directory. If you prefer the
simplicity of the second method, but, like me, your data
is on drives/partitions other than your /home, there is a
way around it. It is also best recommended if you are
the only user for your PC. Otherwise, the other way is
recommended, as others won't have access to them as
they'll be in YOUR home directory.
I want to share certain folders off my drive/partition, but
don't want to share the whole thing (I do have private

25

Easy Samba File Sharing Set Up
stuff there also). If i want to just be able to right-click on
it to share, the simplest way to accomplish this is to unmount the partition and remount it under my /home
directory. It isn't hard at all. Just do this. In the
PCLinuxOS Control Center (yeah, we do everything
from here, I wish others had it, it makes life so much
easier), select Mount Points again, then "Create,
delete, and resize partitions". Click on Continue from
the bubble that pops up. Now, you'll see your hard
drives and their partitions listed. To mount my 2nd drive
(hdb on the top tab) under /home, I click on the tab to
select it, then click on and select the partition, and
choose the "Unmount" button that appears down the
left (make sure you aren't doing anything on it, or it will
throw up an error, as you can't unmount it while it's
being used). The drive is now no longer mounted, and
is currently inaccessible. Now select "Mount point" from
the left-hand options. It will show you the last listed
mount-point for the drive, such as /mnt/hdb1, or in my
case (I already changed the name to something more
recognizable) to /mnt/300GIG (it's a 300 GB drive,
making it easier to locate since I know what is saved to
what drive). To mount it under /home, we change this to
/home/yourusernamehere/namewechose for partition
(eg. /home/david/300GIG), then click OK, and select
"Mount" from the left hand side options. Your
drive/partition is now mounted under /300GIG in your
home folder. If you look in your /home directory now,
you will now see a new folder, named 300GIG (or
whatever you chose to call it). Repeat this for any
drives/partitions you wish to add this way. Click Done at
bottom when finished. Remember, this is only
suggested if you are the only user on the PC, as others
won't have access to your /home directory.

Now, the other "official" way, particularly if the PC is
multi-user, is to, in the PCLinuxOS Control Center
(beginning to see the pattern here?), and select
"Manage Configuration of Samba". If we chose
"Allow all users" then we won't need to create any
users, it's all straight-forward. On the first tab, File
Share, clcik on Add on the far right, and a box will
appear. Now, as we "haven't" moved things to /home
(which is why we're doing it this way), my drive/partition
is still mounted under /mnt/300GIG (though yours might
be /mnt/hdb1, or something similar, it's best to be sure
you know which first), under "DrakSamba Add Entry"
there are 3 boxes to fill, and an "open" button to the
right. Click on the "Open" button, and it will open in your
/home directory (mine being /home/david).
Now, there are 2 columns, and a series of buttons
above them. One button shows my /home/david
directory listed, and has up/down arrows on it. Clicking
on this button shows me 3 options, /home/david,
/home, or / . Click on /, and you will find yourself
navigated to the / (or root directory), where everything
else can be found. Find /mnt, and double-click on it, so
that now you can see everything in /mnt, such as my
300GIG (or whatever yours is called). Select this
300GIG, and you can choose to either share this entire
drive/partition, or double-click on and open it, then
select which folders inside you wish to share. I will
choose, for example, my MOVIES folder, and doubleclick on it to open and display it's contents. Now that
you have opened it, it is now selected. At this point, you
can simply click on OK, and find yourself back at the
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"DrakSamba add entry" box, but now with the share
directory listed at the bottom . Now, at the top line,
"Name of share", call it what you wish it to be seen as
on the network, MOVIES for example. Underneath, in
Comments, I write MOVIES again. I've tried not filling
comments in, but it complains, and asks me to enter a
comment for share. Can't continue without it, so I add
the name again, or at least something else to describe
what's there. Click OK. You've now created a share. To
add more, click on Add at the right, and repeat with any
other folders/partitions you wish to share. Once you've
chosen them, click OK at the bottom.
All your shares should be showing up now on the
network. If not, then, back in PCLinuxOS Control
Centre, click on System, and then "Enable or Disable
Services". Check that Smb is marked as running, and
make sure now has a check in box to start at boot. If
your network shares are still not showing on the
network, click on Stop next to Samba. Then after a few
seconds choose Start again. Give it a minute, and it
should now show. If it still fails (rare), then a reboot
should fix it, and everything should work perfectly.
I currently don't have a working switch to connect my
PCs with and test this, as it's mostly from memory, but it
should all be fine. Feel free to point out if I missed
anything, I can edit to add it in. Like I said, working from
memory, pretty sure, but it's possible I've missed
something. If it still isn't working correctly, go back into
the PCLinuxOS Control Center (after a reboot
preferably) and into Mount Points, then Manage
Configuration of Samba, and where your shares are
listed, double-click on one, or click modify to the right,

and Choose to make the share Public, or Browseable,
by clicking on the box marked so and activating Yes.
Then click on OK and close off. It should be fine.
Please tell me if I'm missing anything, and i'll amend it.
Hope this is of help to those feeling lost when setting up
Samba file sharing.

PCLinuxOS
Phoenix

XFCE
Remaster
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Answers on Page 38

Mark's Quick Gimp Tip
The Gimp is incredibly powerful. When it comes to
digital editing, the Gimp can do anything those higher
end apps can do. Whether it's removing scratches from
old photographs, restoring and sharpening digital
images, or enhancing your photos, the Gimp can do it
all! However, one of the stumbling blocks to learning
the Gimp is understanding the basic idea of "Layers."
Working in Layers allows the user to isolate the portion
of an image so it can be worked on and manipulated
separately form the original (or base image) without
destroying the orignal image. Think of layers as panes
of glass that are placed on top of the photo/image
you're editing. You can then copy and move part of the
base image up and onto a new pane of glass (or layer)
and then manipulate it in any number of ways using
Gimp's digital tools. But most new users have a hard
time understanding how layers work, are created,
moved around, etc. Sometimes,
showing the new user a
completed Gimp file, complete
with layers, is the best way. I've
linked to a photo that I edited in
Gimp. You can download it at:
http://www.georgetoon.com/Gimp
_Tip/September. Extract the .xcf
file and then open it in Gimp. Play
with the layers. Toggle them on
and off, move them around,
erase them, duplicate them, etc.
Have fun with it. In the process,
you'll better understand the whole
idea behind working with Layers.

-Mark Szorady is a nationally syndicated cartoonist. His work is distributed by georgetoon.com.
Email Mark at georgetoon@gmail.com.
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IRC:
IRC: The
The Forgotten
Forgotten Chat
Chat Frontier
Frontier
by Paul Arnote (parnote)
Internet Relay Chat, more commonly referred to as
IRC, is one of the older chat services on the internet.
IRC was started in 1988 (10 years before Yahoo!
released Yahoo! Pager, the forerunner of Yahoo!
Messenger). It didn't really take off until 1991, during
the Gulf War, when updates about the war kept users
“tuned in” to their IRC chat channels.
However, due to the popularity of instant messenger
programs, like Yahoo! Messenger and MSN
Messenger, IRC has became the forgotten frontier for a
lot of computer users. Even today, it lives deep in the
shadows of the various Internet social networking sites.
In a lot of ways, IRC was the Internet social network of
its time. I know this was the case for me, until I started
frequenting IRC again (after a lengthy hiatus) when I
started working on revitalizing the PCLinuxOS
Magazine.

The Past
Back in 1996, when I was still running Windows 95®
and before I knew about Linux, I was running mIRC, a
then-popular IRC client, which is still popular among
Windows users today. Yahoo! Messenger (initially
known as Yahoo! Pager) was still two years from being
released. ICQ would only just be released in late 1996.
The only other way for people to “chat” across the
Internet was via America Online, a.k.a. AOL. And, if you
didn't have an AOL account, that left IRC as the only
other way to chat with users who had interests similar
to yours across the Internet.

Many of you may not have even been involved with
computers at that time, and may not have even had a
chance to use IRC, the grand-daddy of Internet chat
who once ruled the roost. For those of you who fall in
this category, you are in for a treat.
Living at the time in a very small, central Missouri town
whose sidewalks literally rolled up at 7 p.m., IRC was
my connection to the “outside world.” For me, it was
either watch TV or chat on IRC. Since I worked night
shift at the hospital, my “waking hours” were what
everyone else considered “sleeping hours.” Thus, there
wasn't much of anything of interest on late night on TV
(it was even worse then, than it is now). So the choice
was obvious. I'd log in to IRC and spend the evening,
and long into the night, speaking with my “friends” –
other “night owls” – on IRC.
I still have vivid memories of the excitement felt when I
was able to chat, instantaneously, with another user
from another country. Often times, conversations on
IRC went late into the night, discussing every
conceivable topic and solving the world's problems in
the process. In 1998, I knew that I was moving from
smallville, central Missouri, to the hustle and bustle of
the Chigacoland area, in Northwest Indiana. So IRC
helped me make friends in Indiana long before I ever
moved there.
Then, when Yahoo! released their Yahoo! Pager
software in 1998, it literally burst upon the scene with a
fury. Everyone who was anyone was downloading and
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using Yahoo! Pager. For a while, I bounced between
using Yahoo! Pager and my comfortable, old friend,
mIRC. I kept with mIRC mostly, but more and more,
Yahoo! Pager became my software of choice. After a
while, I forgot about that old friend, mIRC. I would
occasionally revisit that old friend, but the visits became
less and less frequent, until they stopped altogether.

Fast Forward To The Present
Now fast forward to June, 2009 – 10 years later. I
needed a better, faster, more immediate way to
communicate with Archie, who truly lives half way
around the globe from me. Brainstorming sessions
simply aren't as effective via email; you need the
immediacy offered by chat software. Late during my
evening, Archie was just starting his day. And early in
my day, Archie was just ending his day. We are literally,
13 hours apart right now, because of daylight savings
time. So, Archie urged me to pop onto IRC.
Once there, things felt somewhat foreign, yet at the
same time, there was something familiar about it all. My
old friend was still there, behaving as it always did,
despite me having forgotten the “lay of the land” and
many of the once-familiar commands. It didn't take
long, though, before I was remembering the old
commands and navigating IRC much as I had 10 years
earlier.
Today, IRC continues to serve its users. In fact, as
recently as May, 2009, IRC was serving more than
500,000 users at one time, through hundreds of

thousands of channels, operating on approximately
1,500 servers around the world.

You Can Join the Fun, Too – XChat
PCLinuxOS makes it easy for you to join in on the fun
and discussions on IRC. In all full PCLinuxOS 2009
installations, there is a chat software client installed by
default, called XChat. While there are other programs in
the PCLinuxOS repository that allow you to connect to
IRC (e.g., Konversation, Pidgin, Kopete, and kvirc,
among others. There is even ChatZilla, an IRC plugin
for Firefox.), we will restrict our discussion to how to
use IRC via XChat. I'll leave the use of the other
programs as something for you to experiment with.
Getting started with XChat is not difficult at all. When
you first launch XChat, you will first be shown the IRC
network window. It is here where you can decide which
IRC network you would like to connect to. There are
several IRC networks to choose from, but for our
purposes, we'll leave it at the default, FreeNode. It's on
the FreeNode server where all the PCLinuxOS IRC
chat channels are located. But you should allow
yourself to explore the other IRC networks. Back when I
was a “heavy” IRC user, EFNet, DALnet, and UnderNet
were all very popular IRC networks. I haven't yet reinvestigated them, as I've been busy, and quite happy,
participating in the discussions on the PCLinuxOS
channels.
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IRC channel names start with “#” at the beginning of
their names. There are several PCLinuxOS channels
already set up for you to chat in. The default,
#pclinuxos, is more of a common area. It's open to
everyone. You can engage in conversations with other
PCLinuxOS users there, but don't ask support type

questions in there. For support, there are two other
channels: #pclinuxos-fixme and #pclinuxos-support.
The fixme channel exists to help you fix problems with
your PCLinuxOS that may be preventing you from
accessing your PCLinuxOS installation, or where you
have limited abilities due to something that may have
gone awry with an update. The support channel is for
all other types of PCLinuxOS support questions. There
is a channel for the PCLinuxOS Magazine, called
#pclinuxos-mag, where everyone and anyone can join
to discuss ideas and topics concerning the PCLinuxOS
magazine. The #pclinuxos-package channel is set up
for the PCLinuxOS packagers. If you are interested in
joining the ranks of the packagers for PCLinuxOS, this
may be the place for you to hang out. Then, there is
#pclinuxos-naughty (no it's not what you think), which is
a channel devoted to discussing PCLinuxOS and its
variants. There are even channels specific for various
members of the PCLinuxOS international community.
For Polish users, there is #pclinuxos-pl, and for French
users, they can chat – in French – in #pclinuxos-fr.
Simply pressing the “Connect” button in the first dialog
box will get you connected, but we can do something
here to improve your experience. First, enter your nick
name that you want to use in IRC in the space at the
top of the window. You can also alter the information
displayed on the next four lines as you choose. Next,
click on the “Edit...” button, and we can set up the IRC
channels we want to automatically log into whenever
we start XChat. On the line labeled “Favorite
Channels:,” list the channels you wish to automatically
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• #pclinuxos
• #pclinuxos-dev (invitation only)
• #pclinuxos-fixme
• #pclinuxos-fr
• #pclinuxos-mag
• #pclinuxos-naughty
• #pclinuxos-package
• #pclinuxos-pl
• #pclinuxos-support
Once you are done setting up your favorite rooms,
select “Close” in the Edit dialog, then “Connect” in the
Network List dialog box. You will now be connected to
XChat, and be connected to the chat channels you set
up as your favorites. Your XChat window should look
something like this:

log into when you connect to the FreeNode IRC
network. Separate multiple channels with a comma.
Again, the choices for the PCLinuxOS channels are:

Although it's a matter of personal preference, we can
modify this window to improve its appearance and
increase its functionality. The default view is called “tree
view.” The “tree” on the left side of the window shows
you all the channels you are connected to. My personal
preference is for the “tab view,” where the channels you
are logged into appear as tabs across the bottom of the
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window. By using the “tab view,” I gain more screen real
estate, width-wise, for my message area (the center
part of the window). To change to the “tab view,” go to
the Settings menu and select Preferences. This will
bring up a dialog box as follows:

Highlight “Channel Switcher,” and change the Switcher
Type from “Tree” to “Tab,” at the top of the dialog box.
Hitting “OK” will change your window to something that
looks like this:

While you are in the Settings > Preferences dialog box,
poke around in there. You can change the font used to
display the text in your message window, the color of
your message text, the default directory where files
shared with you are shared, specify a sound to play
when you receive a message (only sound files with the
*.wav file extension work), time-stamping the
conversations, and lots of other settings. You can even
set XChat to log all your conversations for later
reference or posterity.
Do you notice how some tabs have light
red text (the #pclinuxos channel in the
screen shot)? The color changes to light red when there
are new messages/conversations in that channel. Do
you also notice that some
tabs are in dark red (the
#pclinuxos-package channels in the screen shot)?
Those indicate that someone has either joined or left
the channel. If someone addresses you directly with
your nickname, the channel tab
will be highlighted in blue text.
Tabs with black text have no new messages.
Also, take note of the horizontal red line in the message
window. That red line means you were doing something
else when that message came in, and the XChat
window didn't have the focus at that time. It could be
that you went to check on something on a web site, or
you were typing a paper for school. To catch up on the
conversation or follow what's happened since you
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switched away from IRC, just start reading after the red
line.
The right side of the
screen, whether you are
using the “Tree View” or
the “Tab View,” lists the
users who are also
logged into that specific
chat channel. Notice how
some users have a green
dot next to their name?
These users are the
“channel operators,” or
just “ops.” Other IRC
chat software may use
an “@” symbol to designate the “ops” of the channel.
Their job is to maintain order in the channel. Should
you choose to not adhere to the channel rules and
etiquette, you can either be “Kicked” (where you are
kicked out of the channel for a period of time), or worse,
“Banned” (where your IP address is recorded and you
will not ever be allowed back into the channel). Only
“ops” can “Kick” or “Ban” you. By the way, one sure way
to get kicked out of an IRC channel is to log into IRC
while you running your computer as the “root” user. You
should never log into, or routinely run your computer, as
the root user.
Also, when looking at the user pane, did you notice that
one user at the top had a funny name (in the screen
shot above, it's BabCom)? That is a “bot.” Two other
common names you are likely to see are “ChanServ”
and “BTOB.” The “bot” locks down that specific channel

so no one can “steal it,” and may perform other jobs,
like logging whatever chats occur there, giving “ops” to
certain users, monitoring the channel for adherence to
the rules … pretty much whatever the “bot” author and
user decides that they want the “bot” to monitor.
We can further enhance our chat window by placing
buttons under the user list pane, allowing us to perform
special functions with those users. By highlighting the
name of a user, we can then hit any one of the six
buttons down below.
The Op, DeOp, Ban,
and Kick buttons only
function for those who
are designated as an op
in a channel. You can
also send a file to
someone in a similar
way. Highlight the user's
nickname that you want
to send a file to, hit the
Sendfile button, find the
file you want to send,
and hit OK. It's considered proper etiquette to let the
other user know that a file is forthcoming. Highlighting
the user's nickname and selecting the Dialog button
opens a private chat with that user. Again, it's
considered proper etiquette in some circumstances to
ask the user's permission to send them a private
message. Another use for this it to tell someone in the
chat room something that you don't necessarily want
everyone else to see or know about. We'll discuss
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another way of doing this when we talk about the IRC
commands. You can display these buttons simply by
clicking on the View menu, and selecting Userlist
Buttons.
There is one other enhancement to your chat window
that you may – or may not – wish to make. These are
the Mode Buttons, accessible under the View menu.
These buttons are usually only of use to those who

have op status. To find out what each button means,
simply hover your mouse over the button you want to
know about.
With all these enhancements, this is what your XChat
window will look like:

do. They are relatively simple to learn and use. All
commands are entered on the chat line, near the
bottom of the chat window.
/join <channel-name>
This is the command we use to join a channel. Say you
are in the middle of a chat session, and decide to check
out another chat channel. Simply typing “/join checkers”
(without the quotes) will allow you to join the chat
channel named “checkers” (if it exists … my examples
are only hypothetical).
/me <action>
If you want to let the rest of the channel that you feel
faint, or that you are hot and sweaty, or anything else,
this is the command to use. Typing “/me feels faint”
(again, without the quotes), will display “*parnote feels
faint” in the message window. The action can be
whatever you want it to be. Just remember to keep it
appropriate for the channel you are chatting in, or you
may be finding yourself either kicked or banned from a
channel.
/msg <user> <message>

So now, it's time to get down to learning the commands
that allow us to interact with IRC and its users.

IRC Commands
To interact with IRC, and its users, there is a set of
commands that tells the IRC server what you want to

To send a private message to another user, use this
command. If you type “/msg parnote I need to tell you
something” (without the quotes) will send me, parnote
(my nickname in IRC) a private message that no one
else in the channel can see. In XChat, the user you

35

IRC: The Forgotten Chat Frontier
sent the message to will have their nickname
surrounded by reversed brackets, e.g., >parnote<. If
the user responds to you, it will be in a new tab at the
bottom of the XChat window. In some channels – like a
singles channel – it's customary, and proper etiquette,
to ask someone permission to send them a private
message before doing so.
/nick <new-nickname>
If you want to change your nickname in the middle of
your chat session, enter “/nick TheGrimReaper”
(without quotes) to change your nickname to
“TheGrimReaper.” Be sure your nickname is
appropriate for the channel you are chatting in (and all
the PCLinuxOS channels are considered “family”
channels). Otherwise you may find yourself kicked or
banned from a channel.
/notice <user> <message>
Similar to the /msg command, this command sends a
message to another user, but without opening a private
chat window.
/part
To leave a channel, simply enter “/part” on the message
entry line. To leave all of the channels you are currently
chatting in, enter “/partall” on the message entry line.

/ping <user>
Entering “/ping parnote” will give you the ping time, or
lag time, between you and the person you pinged. Of
course, you would replace my nickname with the
nickname of the user you are wanting to ping. Lag time
is the amount of time it takes from the time you type a
message and it appears for others to read your
messages.
/quit
Typing “/quit” on the message entry line causes you to
leave IRC altogether, disconnecting you from the IRC
server.
/ignore <user!*@*>
Sometimes, you may encounter someone who really,
really annoys you. Or maybe there's someone who has
a habit of harassing you. Or maybe there's some user
that you just don't want to receive messages from (an
ex girlfriend, boyfriend, wife, or husband perhaps?).
This command allows you to ignore the specified user.
Just enter “/ignore billybob!*@*” to ignore the user with
the nickname “billybob.” To ignore all users with
“billybob” as a part of their nickname, enter “/ignore
billybob*!*@*” and “billybob,” “billybob25,” and
“billybobruns” will all be ignored. Adding NOSAVE at the
end of the line will make the ignore command only
effective for that chat session, and remove the ignore
when you quit IRC. There are many other options for
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this command, and you can read about them by
following the links at the end of this article.
/unignore <user!*@*>
If you change your mind about ignoring someone, this
command reverses the ignore command. It uses a
syntax similar to the ignore command. So, if you decide
that you would like to see messages from “billybob”
again, just enter “/unignore billybob!*@*” on the
message entry line.
/chat <user>
Sometimes, you may want to engage in a private chat
with another user, independent of the IRC network. The
“/chat timothy” command will send a DCC Chat request
to the user “timothy,” and if he accepts, you can
continue to chat, even if you get get disconnected from
the IRC server. Warning: do NOT accept any DCC
request, whether it's for chat or file sends, from people
you do not know.
/whois <user>
There are times when you may want to know if
someone is who you think they are, or other times you
may want to know more information about a user (like
who their ISP is, their IP address, what other channels
they are in, etc.). The “/whois charlieboy” command
would tell you all that information about the user
“charlieboy” (if he exists). The information will appear in
the main window or tab from the IRC network you are
connected to.

/away <optional message>
If you enter “/away going to bed now” in the message
entry line, you will remain logged into IRC, but your
user nickname will be marked as being away. If you
have XChat set to display “away” messages, your
status will display in the message window as “*parnote
is away: going to bed now.” If you omit the optional
message, you will still be marked as away, and only
“*parnote is away” will be displayed, unless you've
defined a standard away message in the XChat
preferences dialog.

What now?
Now you know what the basic commands are to
participate on IRC. The rest is now up to you. Go out
and explore the different IRC networks. Try out the new
commands you've learned. IRC really can be a fun way
to communicate with others from all around the globe.
Before you do, however, let me remind you that IRC is
primarily intended to transfer text. It is unencrypted, and
thus security is your responsibility. It's not advisable to
share personal information that you don't want
everyone to have access to.
There are a lot of other resources for information on
IRC. For example, you may wish to look at the full set
of commands to see what all you can do while on IRC.
I've only given you the basic command set here. There
are many more commands available.
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So, here are some resources that you may find
particularly useful:
• XChat Help:
http://t0x.in/xchat.html
• XChat Main Page:
http://xchat.org/docs/
• IRC Beginner:
http://www.ircbeginner.com/ircinfo/ircclass.html
• Advanced IRC Commands:
http://www.irchelp.org/irchelp/misc/ccosmos.html
These should get you started quite well towards
learning and using the grandfather of Internet chat
software. Maybe IRC isn't so forgotten after all, but
rather is alive and well, still keeping users connected
more than 20 years after its debut. IRC was “social
networking” before the rest of the world even knew
what social networking was.

Answers to Mark Szorady's Double Take: (1) Hat
backward; (2) Thermometer moved; (3) Keyboad
keys smaller; (4) Shirt stripes different; (5) Arm
moved; (6) Cabinet shorter; (7) "Has" changed to
"Got."
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PCLinuxOS
PCLinuxOS 2009.2
2009.2 on
on Acer
Acer Aspire
Aspire One
One

by Andrew Huff (athaki)
In this short article I would like to detail my experience
with PCLinuxOS on my Acer Aspire One.
I downloaded the PCLinuxOS 2009.2 iso file and used
UnetBootin to install it to my 1GB flash drive. Once I
loaded I logged in as root, clicked install, and followed
the prompts. It couldn't have been easier. The install for

PCLinuxOS on this machine went pretty standard and
within 20 minutes I had a working PCLinuxOS
installation on my Aspire One. Everything except having
the card readers hot-pluggable and the Fn keys for
audio worked out of the box. The fix for the Fn keys is
easy; go into PCLinuxOS Control Center and select
Hardware and then keyboard layout. What worked for
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me was selecting the keyboard type Acer Travelmate
800, as seen in the screenshot below.

options pciehp pciehp_force=1
pciehp_slot_with_bus=1

A suggested card reader fix is as follows, although your
mileage may vary (it has been reported to work for
some users, and not others):

install sdhci for i in 2381 2382 2383
2384; do /usr/bin/setpci -d 197b:$i
AE=47; done; /sbin/modprobe --ignoreinstall sdhci

1) Create a file /etc/modprobe.d/aspire-fix-sd-slots with
the following contents:
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2) Then add the following line to /etc/modules:
pciehp
Next, you need to disable the Memory stick, to avoid
hanging at boot.
3) create a file /etc/modprobe.d/aspire-blacklistmemstick with the following contents:
blacklist jmb38x_ms
blacklist memstick
This should allow you to have your card readers
working in top form, or you can do what I did and just
have the SD card in the reader at boot, since the SD
card is recognized if it is inserted prior ot boot.
The only caveat's in this operating system are not due
to the OS itself, but due to the small screen size of the
Aspire One. Menus are rather cramped, but they are
still functional. All in all, PCLinuxOS suits the Aspire
One rather well.

Anagrams
An anagram, as you all know, is a word or phrase made
by transposing or rearranging the letters of another
word or phrase. The following are exceptionally clever.
Someone out there either has way too much time to
waste or is deadly at Scrabble.
Dormitory
Evangelist
Desperation
The Morse Code
Slot Machines
Animosity
Mother-in-law
Snooze Alarms
Alec Guinness
Semolina
The Public Art Galleries
A Decimal Point
Eleven plus two
Contradiction
Astronomer
Year Two Thousand

Dirty Room
Evil's Agent
A Rope Ends It
Here Come Dots
Cash Lost in 'em
Is No Amity
Woman Hitler :)
Alas! No More Z's
Genuine Class
Is No Meal
Large Picture Halls, I Bet
I'm a Dot in Place
Twelve plus one
Accord not in it
Moon Starer
A year to shut down

This one's truly amazing, as a grand finale:
That's one small step for a man, one giant leap for
mankind. -- Neil Armstrong
A thin man ran; makes a large stride, left planet, pins
flag on moon! On to Mars!
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Forum
Forum Foibles:
Foibles: Forum
Forum Signatures
Signatures
This month, ms_meme takes a look at some of the
"words of wisdom" that users relay in their forum
signatures.

MeeMaw
Never stop learning!

JayDot
PCLinuxOS Get it. Got it? Good!!

maddogf16
I'll stop learning when I'm dead!!

hornerm
Old Computer People Never Die They just Lose Their Memory

Crow
School is not out, yet

coolbreeze
May the Big Guy slap you with Wisdom
Bubba
The extra mile is the stretch of road
that is never crowded
Neal
I'm not smart enough. I don't know enough. But I'm
certainly stubborn enough!
ms_meme
I don't tell lies, but I don't mind uttering nonsense.
wlan
Light Travels Faster Than Sound, Which Is Why Some
People Appear Bright Until You Hear Them Speak.

YouCanToo
Linux is user-friendly - it's just picky who its friends are.
parnote
In a world without walls, who needs Windows?
Wildman
Most of the stuff people worry about ain't never gonna
happen anyway
Joble
Hero means I talk a lot, nothing more, nothing less!
Papawoob
I have found that most of what I know was learned
while searching for answers to something else!
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Behind
Behind The
The Scenes
Scenes
An Interview With Neal Brooks
by Paul Arnote

Editor's note: This month, we get the opportunity to
meet with Neal Brooks, and get a chance to get to
know him better. Neal, who has recently completed the
PCLinuxOS LXDE Remaster, named PCLXDE, and
who has been very busy packaging RPMs for the
PCLinuxOS repository ... in addition to serving as a
moderator on the Package Suggest and Packager's
sections of the main forum and Global Moderator on
MyPCLinuxOS community projects forum ... takes a
few minutes out of his busy schedule to answer some
questions for PCLinuxOS Magazine.
Can you tell us more about yourself? ("Real" name,
where you live, marital status, kids, pets, etc.)
My name is Neal Brooks. I reside in Tennessee in a
small town within a couple hours drive of several larger
cities and towns. From my yard, I can view beautiful
mountain scenery. On clear days, the view is awesome.
On cloudy days, there's a view that the artist in my soul
responds to with joy.
I've been married three times, though I currently live
alone. I have a son, aged 34, three wonderful
granddaughters and a great Daughter-in-Law. At
present, I have no pets, though I suppose a cat will
come along and adopt me at some point. Meanwhile,
the local birds and squirrels treat me rather well. They
will occasionally sit on my porch railing and "talk" or
sing to me.
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When did you first get interested in computers, and
what is your history with computers?
In the fall of 2004, I received my first computer, an old
Compaq with Windows 95. I had to teach myself how to
use it, as I had no tech support and almost no idea of
how to do anything.
How did you get started with Linux?
It was within the first couple of months of using that
computer that I first encountered the GPL. It amazed
me! I began searching to find out more about this idea
of something not locked up tight by a license but being
opened by a license.
I first read of Linux at ZDNet. I would read through the
comments to articles and both Linux and BSD were
often mentioned. One of my favorite responders was
Alan Cox. Though all of the responders caught my
attention with what they had to say, it was his
responses that lead me to decide to find out more.
I can laugh about it now, but my earliest searches were
very disappointing. I was still very new to the Internet
and had little knowledge of what to search for or how to
search for it. I found several sites selling Linux but at
prices way out of my league. I know now that those
sites were selling enterprise level system CDs and
support, but then I was disappointed.
A few months later, I became acquainted with a man
who worked with Linux systems. He explained about
the difference between enterprise systems and

community distributions. We had a good laugh over my
search terms. Having learned what to search for, I
started running across many references to Ubuntu. I
downloaded and burned many unbootable CDs. It was
quite frustrating. Eventually, I drove the 120+ miles to
see my new friend, and he gave me a set of Fedora
Core 4 CDs. I installed it and used it over one weekend.
But there were problems that I later learned were from
a bad burn.
When Fedora Core 5 was released, I downloaded and
burned a set of CDs using K3B on a new installation of
Fedora Core 4. I used it for quite some time, but I
managed to break it quite often. After one reinstall yes, I broke it that badly - I downloaded and burned a
copy of Ubuntu. I had problems with it straight away. I
could not set up a firewall without trashing the system,
among other things. Having learned to be paranoid
about security while using windows, this upset me quite
a bit. I spent quite a bit of time reading through the
Ubuntu online help but found no solution that worked
for me. It was disappointing. It felt like I was personally
failing.
So I went back to Fedora, as I knew I could use it, if I
were careful. I had learned enough by this time to keep
my installation of Fedora from crashing; that is, I had
learned a lot of things not to do.
Always hungry for more knowledge, I spent a lot of time
reading posts on Fedora Forums. I often had problems
with understanding what I read, but I kept at it. Then
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one day a miraculous event occurred. Well, miraculous
for me, anyway. In one member's signature was a
reference to PCLinuxOS. I clicked the link and read the
web page. As I had learned to be more cautious after
my failure with Ubuntu, I thought about it for a while
before I decided to give it a try.
That is where the miracle occurred. Finally I had found
a system that was usable and stable from the first boot
up of the live CD. I suppose you could say that that was
the moment that I truly began to learn about computers.
With a stable system under me, I could surf the web
and spend hours reading and learning. That system
was .93 MiniMe beta. .92 was out at the time, but I had
liked the idea of a smaller system that I could set up to
suit myself.
When did you make the switch to PCLinuxOS as
your primary Linux distro, and why PCLinuxOS?
In late spring of 2005, my true journey with Linux
began. I still had a lot to learn, but the ability to do so
securely with a stable system under me gave me the
opportunity that I'd hungered for all of my life. I had
found the system that was "Simply the Best." I had also
discovered that there was a wealth of knowledge
posted on the forums, either directly or via links. I took
shameless advantage of this to dig in and learn.

your job as a moderator of those boards, and how
do you handle it?
The most challenging part? Hmm...... there are many
things about it that are challenging. I suppose the
biggest challenge is to overcome any reticence at
stepping forward to moderate someone. It's easier for
me to put myself in someone's place than to moderate
them, even mildly. I'm grateful that I've never had to do
any strong moderating. We do have a most wonderful
community.
What is the most rewarding aspect of being a
moderator?
The most rewarding part is that I continue to be a
member of the community. I'm just one of 'the family'
with a specific job to do, like any other member who
contributes to our beautiful online 'home.'.
What made you interested in learning how to
package RPMs for PCLinuxOS?
Two things were on my mind at the time. I had a strong
desire to contribute and, as always, a desire to learn.
The documentation was available, and the forum for
packagers was easily accessible. I guess you could say
that I saw an open door and stepped in.

Many know you as a moderator in the Package
Suggest and Packaging boards of the main
PCLinuxOS forum, and a Global Moderator on the
community project forum at MyPCLinuxOS. What
would you say is the most challenging aspect of
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What has been the most challenging RPM for you
to package for PCLinuxOS, and why?
In a way, they are all a challenge. Any time you start to
package an RPM, you face the possibility that there will
be errors that you have no idea how to overcome.
That's what the packager's section of the forums is
about. It is a place to share questions and knowledge.
Not too long ago, I took a whack at updating some of
the system tools to see what I could do. It was no easy
task, and I was not successful. At some future time, I
will try again. It is just a matter of learning and going
forward.
What single RPM has given you the greatest
personal pleasure to have packaged for
PCLinuxOS, and why?
It gives me a great deal of pleasure when I can
successfully package any RPM, but recently I've had
the opportunity to package GetOpenOffice. That was
very satisfying on many levels. I had had the privilege
of testing it for Pinoc. It was a distinct honor, as well as
a pleasure to work with him. When I wrote the spec file,
and the package built, there was a feeling that is
indescribable.
You recently headed up the project to create a
PCLinuxOS LXDE remaster, called PCLXDE. What
inspired you to create PCLXDE?
The idea came to me just before I started on the
Quarterly Update project. I had added task-lxde to my
install and found that I liked it. After my work on 2009.2

was completed, Texstar mentioned that an LXDE
remaster was on the "to-do" list. I asked if I might do
that, and he said yes. And the rest is, as they say,
"history."
What was the most challenging aspect of creating
the LXDE remaster?
Choosing and setting up the DM (desktop manager)
was the most challenging, I think. I started out trying to
use SLIM, but it continually refused to launch LXDE.
After reviewing the options, GDM was chosen. I believe
that it has worked out well.
What was the most rewarding aspect of creating
PCLXDE?
Each little triumph in setting up the system was richly
rewarding. Taken all together, they comprise a feast of
many delights. It was most rewarding to have the
chance to work with other community members on the
project. I suppose the most rewarding of all was seeing
the announcement of its release.
What was your criteria for deciding which
applications to include in PCLXDE?
Native LXDE applications were decided on first, of
course, and as we wanted the release to be a
lightweight environment, we looked at lighter
applications. There are quite a few to choose from. The
selections were changed a few times during the
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process of putting PCLXDE together. Several test runs
were made, which lead to changes. Eventually, we
settled on a set and proceeded from there.
How has your background prepared you for the
challenges of packaging and creating PCLXDE?
I was always a bibliophile, what they used to call a
bookworm. I spent many hours alone with my books
and was quite happy. When I was introduced to the
Internet and began to see the possibilities of reading,
not just published books but the writings of people from
around the world, it was like I had stepped into a library
of near infinite proportions. Despite those early
problems I had with learning how to use it, I knew I had
found something great.
From an early age, I had been taught the value of
sharing. Too, I had been creative from an early age.
When I found Linux, and in particular, when I found
PCLinuxOS, I found a way to do both in a way that was
fun. You see, one of the things I had learned about the
Open Source world was that anyone could make a
contribution. No one is excluded. Anyone can learn.
Anyone can contribute. You may need to search about
for your niche, but if you are determined, you can do it.
I suppose you would say that my philosophy is give,
and it will feel good; have fun doing it, and it will feel
even better; create what you share, and perhaps others
will be inspired to be even more creative and sharing.

Has your experiences -- both successes and
failures -- with packaging and creating PCLXDE
changed, or challenged, your view of FOSS, and
how?
I think the name says it all. Free and Open Source
Software. Freedom offers so much to us that it could
take a long time just to explore all of the aspects of it.
Opened up to unlimited viewing, the source of any
software, or system is there for the newest of the new
and the most experienced.
Whether working on a package or PCLXDE, I
experience this freedom and openness. To know that I
am free to do whatever I choose is a bit heady, but the
knowledge of that freedom brings with it the knowledge
of the responsibility that goes with it. Any change you
make you must take responsibility for. I think that now,
more than ever, I understand the responsibility that
goes with being free.
What advice would you give to anyone who wants
to learn how to package RPMs for PCLinuxOS, or
who may want to join the PCLinuxOS Packaging
Crew?
Go for it. Very good documentation is available. If you
commit yourself to learning, you'll find that there's
plenty of knowledge already there for you to take
advantage of. Help from fellow packagers is available, if
it is needed. That's the beauty of the packager's forum.
I recommend reading the posts of those who have
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asked for and received help there. There is a great
wealth of knowledge there in addition to the
documentation available.

What "words of wisdom" would you like to leave us
with?

So let nothing hold you back. Go ahead and learn.

You want wisdom? Hmm.......... better ask Texstar. He'd
have some wise words, I'd bet.

What other projects, other than packaging and
creating PCLXDE, are you currently involved with?

Or how about I share what I consider to be the most
powerful words ever spoken? : "You can."

There's the Quarterly Update CD project, and I do
some testing - as much as I can, anyway. I've just
finished up lxcursor, which is a small app for changing
the cursor theme on PCLXDE. Many thanks go to
Texstar, Pinoc and Travisn000 for invaluable assistance
on that one. I'd still be working on it, if they had not
been there to help.
Now that you have completed PCLXCE, what do
you anticipate being your next big project (if you
can reveal it to us)?
Well, there's one project I have in mind that's in the
early research stage. It will be a while before I'm ready
to talk about it, if that day ever comes. Projects can die
in the planning stage, but there's always something to
do.
I have my fingers in about a dozen other pies. LOL
Maybe that's an exaggeration. I do believe in
contributing what I can, where I can. Whether it is only
a small involvement or taking the lead, the opportunity
to give back to the community and PCLinuxOS is a joy
to my heart and great fun. I love it.
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Computer
Computer Languages
Languages A
A to
to Z:
Z: C/C++
C/C++
by Gary L. Ratliff Sr. (eronstuc)
This is the third in my series on computer languages. It
seems that due to a mix up in a previous changing of
"the guard," my promised follow up to show information
on the commercial version of APL was never published.
However, I did post a video of the install of APLX 4.1
on YouTube. Just search for eronstuc and you will see
a list of the items I've uploaded.
With the magazine back on a monthly publication
schedule, the plan is to discuss, in alphabetical order,
the various programming languages that are available.
In case you missed the previous articles, you can view
the first, on APL, in the July, 2008 issue of the
PCLinuxOS Magazine. You can view the second article,
on Basic, in the October, 2008 issue.
This article will concentrate on C and C++. C is the
language which was used to port the original Unix
operating system from the assembly language for the
PDP computers it was originally written with. Due to its
wide acceptance, it was responsible for the growth of
Unix and was used to write most of Linux. This can
easily be learned by anyone who choses to pursue the
reading of the source code of the operating system.
KDE, on the other hand, uses C++ for its applications.
C++ is a superset of C and the current version of C++
supports all the features of the C89 standard for the C
language. However, some new features for C were
introduced by the C99 standard, and these new
features are not incorporated into the current C++
standard. However, a recent email to me from Herbert

Schildt who was a member of the C++ standardization
committee let me know that most of the features which
are not included in the current version of the C++
language, which are part of standard C99, will be
incorporated into the next standardization of the C++
language.
Preparing your computer to program in C/C++
As I have upgraded from PCLinuxOS 2007 to
PCLinuxOS 2009.1, I believe that the gcc compiler is a
part of the tools on the default install. At first gcc meant
the GNU C compiler. Now it refers to the GNU Compiler
Collection and, at present, this contains front ends for
C, C++, Objective-C, Fortran, Java, and Ada. You may
easily verify if you presently have this compiler installed
by entering gcc -v in a terminal window.
If you receive a file not found message, then you will
need to also install the gcc package. That the g++ front
end for the gcc suite is not installed by default may be
learned by entering g++ -v instead of the gcc line as
above. This should generate the file not found
message. Now, to install the g++ compiler, you will
need to become root:
su
«enter the root password»
apt-get install gcc-c++
Here the system will analyze your currently installed
software and list all the dependencies required to
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upgrade your
system to be able
to compile C++
code. This will
almost always
include the
libstdc++ libraries.
While you are at it
you might as well
install the debugger
program gdb by
issuing the
command:
apt-get
install gdb

Reference
Materials to Aid in
Learning C/C++
The Complete
Reference C Fourth
Edition
by: Herbert Schildt
Copyright © 2000
by The McGraw-Hill
Companies
C++ ALL-IN-ONE
DESK
REFERENCE for
DUMMIES
by: Jeff Cogswell
Copyright © 2003
by Wiley
Publishing, Inc.,
Indianapolis,
Indiana

This operation may
also be performed
using synaptic. Just
use the search
Here synaptic reveals that the C++ front end for the GNU Compiler
feature to find c++
Collection has been installed.
and then later gdb.
Here you will learn that gdb is a source level debugger
Beginning Linux Programming 4th Edition
for the C, C++, and Fortran languages.
by: Niel Matthew, and Richard Stones
Copyright © 2008 by Wiley Publishing, Inc.,
Next we will list all the books which were used as a
Indianapolis, Indiana
reference for this article. The following books are
reliable reference materials to help you learn to learn to
The Beginners Guide to C++
write and compile applications in these languages.
by: Oleg Yaroshenko
Published by Wrox Press Ltd. Birmingham, UK
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Practice Practice Practice
This last mentioned book is out of print. And as I result
all the example programs were typed into my system
and saved to an area named mycpp on the C:partition
of my Windows system.

publishers. In each case, once you arrive at the site,
enter the name of the volume into the search engine,
and soon you will receive a message which will have a
download tab. When the item is downloaded, it will be
in either zip format or tar.gz. So if you have the GNU
version of the tar utility (which is the case with Linux)
you can unzip and untar in one simple step:
tar -zxvf 780.........tar.gz (or tar zxvf 780......tgz)

There are several advantages to getting these books.
The Jeff Cogswell volume comes with a CD which
contains all the source code, as well as some very
useful development systems for use with Windows.
(Yes, I realize that this is on PCLinuxOS, but there is
also a chance may dual boot your computer with some
Windows Operating system.) You may as well develop
programs from the tools supplied with these books, as
they are free with the purchase of the book. The source
code for the texts by Schildt and the Matthew/Stone
may be obtained from the web sites of the respective

The volume in zip format will be extracted with just the
gunzip command. Now
some of the volumes will
have each chapter, also in
a tarred and gzipped
format. Once the source
file is displayed, you will
move it into an area from
which it may be compiled
and setup to run on your
system. In my case, the
archive was stored on the
desktop and I created a
bin and csource directory
to the /home/gary area. Also by copying or moving
them, you will acquire the necessary permissions to
operate upon the files.
The Cogswell volume contains a Dev-C++ IDE, which
will allow compiling all the examples in his text. The
Dev-C++ is also available in a Linux version. Its main
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advantage is allowing compiling multi-source systems,
without the need to create a makefile. This CD is
obtained from them and also contains many other files,
including a system for compiling Pascal. Also in the
compiler area are versions for a command line Borland
C/C++ compiler, and Windows versions based on the
gcc compiler for MinGw and Cygwin. Cygwin gives your
Windows system a system which runs most familiar
Linux commands.

Here you can see that if you select the free Borland
builder product, once you register, you will have plenty
of time to use the system. 354975 / 365 shows that your
registration will still be good for over 97 years. If you
saved this to CD for backup, the CD is only known to be
safe for 30 years!! By this time Microsoft will have
thrown in the towel and gone open source so that it too
can have the best software developers in the world
fixing its code.

The text is available in bookstores. However, the
comment to contact the author of the book, either at his
website or via email, will not yield any reply other than
to learn that these are not available. Writing to the
publisher directly will resolve most problems. This will
even give a pointer which will allow you to acquire the
very powerful Borland 2006 Builder Software
Development System. Once you get setup with a
password to download and install the package, you
learn that this expires in 37,750 days. Don't worry that
translates into more than 97 years and if you are old
enough to be reading this article you are very likely not
going to have the software expire before you.
The C and C++ languages are both classified as simple
because they have very few built in commands. What
gives them their power is the vast number of libraries
which have been developed, which allow you to easily
harness systems developed by many skilled
programmers who have gone before you. You can learn
either language by just reading the books. That comes
from reading and entering in the programs and
compiling them. Most errors will soon be found to be
key in errors if you manually enter the text of the
programs. Having the source code readily available as
zip files for you to download will greatly reduce this
problem.
When reaching the end of the Beginning Linux text, the
last two chapters deal with developing GUI applications
for GNOME and KDE. Here you will need to install the
libraries for these systems. PCLinuxOS has a version
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which is based upon KDE and another version which is
based upon GNOME. For the GNOME desktop
environment, you will need to install the GTK+
development libraries. For the KDE desktop
environment, you will need to install the KDE
development libraries. Working through the text, it was
amazing just how easily the GUI systems were created.
The GTK+ libraries add GObject, which adds object
orientated features to the C language.
The Cogswell text will also introduce you to the very
powerful SciTE editor. This editor has highlighting for
very many different computer languages. It also will
automatically indent the text as required for the various
levels of the code. Proper indentation would be ignored
by the compiler but makes the text much more easily
understood by you or a fellow programmer who is
attempting to track down an elusive bug. The SciTE text
editor is available in the PCLinuxOS repository.
These volumes also cover using the debuggers in
some detail. The Cogswell text comes with the Insight
Debugger, which is useful for finding errors on items
developed on Windows. The Matthew/Stones text
covers the use of the gdb product.

understanding will make your perusal of the source
code productive.
Other Sources for Learning C++
The text books suggested are not the only methods of
learning the C++ language. By performing a search in
Google for C++ tutorials, you will learn that there are
several. Microsoft will even allow you to download an
older version of their Visual Studio C++ development
package. Included is a video by one of the software
engineers from Microsoft which illustrates how to use
their product. However, my experience with the free
Visual Studio C++ was that all programs entered failed
to function because a cmd file could not be be found. I
verified that I had downloaded the version for the XP, as
cmd files are used in NT. However, this same site
suggested that if you were just learning C++, you
should visit a tutorial site where you could download
twelve lessons in PDF format, which teach the C++
language.

So if you have ever wanted to learn to program or to
learn how your computer functions in some detail,
learning C and C++ is the required first step to being
able to understand the source code of the system. The
Beginning Linux Programming text is not really for
beginners, but gives the person a comprehensive
understanding of how the features of Linux are used in
the development of computer applications. Such a deep
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Scripts-R-Us: Repo Speed Test
by Don Crissti
A few months ago, one of our forum members asked for
a basic script that would test the download speed for
various PCLinuxOS repository mirrors. This article is
based on the script posted on the forum and will
assume you have very basic knowledge of
programming concepts like variables, loops, conditional
blocks. These concepts are mostly the same across all
platforms and programming/scripting languages, so
reading any tutorial for beginners should get you
started.
So, how could we test the mirrors speed? One way to
do it would be to download the same file from each
mirror and then compare the results (the time needed
to complete the download will be used to calculate the
download speed of each mirror at that particular time of
the day).
Our test file should be small enough but not too small
as that would make our results irrelevant. Also, it has to
be in the repos regardless of the software that comes
and goes. One of the best candidates would be
srclist.main.bz2 located in the base section of the
repo, as this file has an optimal size (around 400K) and
is always there. Since some mirrors might be offline for
maintenance, or really slow to respond, we will first test
if they respond in a timely manner and only then test
their speed. After running the speed test, we will
process the results and output a sorted list (starting
with the fastest mirror). We should also inform the user
if any of those mirrors timed out, or if the URL could not
be found.

Any scripting language would be OK for this task,
though Perl was my language of choice here. With Perl,
there is a thing called CPAN, and it has literally
thousands of modules of which many will make your life
so much easier.
Let's move on...
All Perl scripts start with the famous she-bang line:
#!/usr/bin/perl
Linux takes the presence of the first two characters as
an indication that the file is a script, and tries to execute
that script using the interpreter specified by the rest of
the line.
Note that in Perl, every simple statement must end in a
semicolon, unless it is the final statement in a block (put
the semicolon in anyway because you might eventually
add another line).
The next two lines will force you to write better code.
You should use them every time you write a Perl script
as they will help you a lot:
use strict;
use warnings;
The line 'use strict' turns on the 'strict' pragma, which
forces you to declare your variables with the my
keyword, and also spits out errors if the code contains
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any barewords that can't be interpreted in their current
context. The 'use warnings' line means all possible
warnings are enabled, and it's the cheapest way to find
bugs.
Also, we're going to use two Perl module in our script:
Time::HiRes and LWP::UserAgent. The first one helps
us calculate the download time and the second one is
our web user agent:
use Time::HiRes qw(gettimeofday);
use LWP::UserAgent;
Now, what is that qw thing ? The 'quote word' function
qw() is used to generate a list of words. In the above
case, it has the effect of importing the gettimeofday
function from the Time::HiRes module. It does this by
providing the list 'gettimeofday' to the use function.
Next, we're going to define some of our variables. Perl
has three types of variables and uses different symbols
as prefixes for each type of variable:
* a scalar stores a single value and it is prefixed with a
dollar sign ($)
* an array stores a list of values and it is prefixed with
an at-sign (@)
* a hash is an associative array (a paired group of
elements) and it is prefixed with a percent sign (%)
We will only use scalars and arrays in our script.
If you study the URLs for our test file you can see they
all have a similar format:

*tp://***/...../pclinuxos/2007/base/srcli
st.main.bz2
We're going to split the links right before that common
part and recreate them later when needed. There are
mainly two reasons for that:
* we want our code lines length under 80 chars (it's not
a must though... but it's nicer)
* second one might sound weird but believe me it's
true: code guys are lazy... :-)
Also, we need to define three arrays here: the one that
will hold the test results, the one that will hold the list of
mirrors that timed-out or are not valid (if any) and the
one that holds the list of our mirrors. The first two arrays
are empty at this stage of the script.
my $testfile =
"pclinuxos/2007/base/srclist.main.bz2";
# a scalar
my @timedList = (); # an empty array
my @badList = (); # another empty array
my @reposList = (
"http://ftp.riken.go.jp/pub/Linux/pcl
inuxos/apt/",
"http://ftp.kddlabs.co.jp/Linux/packa
ges/pclinuxos/apt/",
"http://ftp.jaist.ac.jp/pub/Linux/PCL
inuxOS/apt/",
"http://mirror.pclinuxclub.com/pclinu
xos/apt/",
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"http://www2.mirror.in.th./osarchive/
pclinuxos/pclinuxos/apt/",
"http://ftp.twaren.net/Linux/PCLinuxO
S/apt/",
"http://gnupg.cdpa.nsysu.edu.tw/Linux
/PCLinuxOS/apt/",
"http://mirror.internode.on.net/pub/p
clinuxos/apt/",
"ftp://mirror.aarnet.edu.au/pub/pclin
uxos/apt/",
"http://na.mirror.garr.it/mirrors/pcl
inuxos/apt/",
"http://ftp.ch.debian.org/mirror/pcli
nuxos/apt/",
"http://gnustep.ethz.ch/mirror/pclinu
xos/apt/",
"http://debian.ethz.ch/mirror/pclinux
os/apt/",
"ftp://ftp.pbone.net/pub/pclinuxos/ap
t/",
"http://ftp.klid.dk/ftp/pclinuxos/apt
/",
"http://mirrors.lastdot.org:1280/pclo
s/apt/",
"http://mirrors.xservers.ro/pclinuxos
/apt/",
"http://ftp.heanet.ie/pub/pclinuxos/a
pt/",
"http://ftp.belnet.be/mirror/pclinuxo
nline.com/apt/",
"http://ftp.nl.freebsd.org/os/Linux/d
istr/texstar/pclinuxos/apt/",
"http://ftp.sh.cvut.cz/MIRRORS/pclinu
xos/apt/",

"ftp://cesium.di.uminho.pt/pub/pclinu
xos/apt/",
"http://distribcoffee.ipsl.jussieu.fr/pub/linux/pclinuxo
s/apt/",
"http://ftp.cc.uoc.gr/mirrors/linux/p
clinuxos/apt/",
"http://ftp.leg.uct.ac.za/pub/linux/p
clinuxos/apt/",
"http://spout.ussg.indiana.edu/linux/
pclinuxos/pclinuxos/apt/",
"http://ftp.uwsg.indiana.edu/linux/pc
linuxos/pclinuxos/apt/",
"http://ftp.ussg.iu.edu/linux/pclinux
os/pclinuxos/apt/",
"http://pclosusers.com/pclosfiles/",
"http://distro.ibiblio.org/pub/linux/
distributions/texstar/pclinuxos/apt/"
); # array containing our mirrors
URLs
Now, we print to the terminal that we are downloading
our file from each mirror and add a new empty line after
our message, so that it looks nice in terminal:
print "Downloading srclist.main.bz2 from
each mirror...\n";
The \n means the n is “escaped”, thus it has a special
meaning to Perl, i.e. add a new line.
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Let's run our test for each and every mirror in our
@reposList. For that we use a foreach loop – the name
says it all, it runs the same code block for each element
in our array:
foreach my $url (@reposList) { #
foreach loop: for each element execute
code block
In our code block, we will recreate the complete URL
for our test file (by concatenating each element of
@reposList and $testfile), we'll fire up a web user
agent:
my $link = "$url$testfile";
concatenate: recreate original link
my $ua = LWP::UserAgent-»new();
# fire up new web user agent

#

and we instruct it to test whether the mirror times out,
show progress during download and time the download
of the test file:
$ua-»timeout(3);
# set timeout
interval
$ua-»show_progress('TRUE');
#
turn on progress indicator
my $t0 = gettimeofday();
# get
time right before download
my $response = $ua-»get($link);
# download test file
my $t1 = gettimeofday();
# get
time right after download

Now that we got our result, we're going to use some
programming magic called “regex”:
$url =~ s|(\w+://.*?)(:\d+)?/(.*)|$1|;
# use regex to format URL
We used regular expressions to alter the URL string.
We want to show the user something readable and
easy to figure out, therefore we want to keep only the
server name and disregard the port number (if any) and
the rest of the path. I won't get into details, as
explaining regexes is beyond the scope of this article.
If the response is successful, we'll add the mirror and
the time result to our @timedList; if not we'll add it to
our @badList. For that, we use a conditional block and
Perl's push() function – as the name says, it pushes a
value onto the end of an array.
if ($response-»is_success) {
conditional block: if condition...
my $delta = ($t1 - $t0);
calculate download time
my $line = $url.' '.$delta;
line up URL and corresponding time
push(@timedList, $line);
add line to the timed mirrors list
}
else {
# end of if
block, start of else block: if not
condition...
push(@badList, $url);
add URL to the bad list

#
#
#
#

#
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}

}

# end of else block
# end of foreach loop

As you can see, we declared some of our variables
inside the foreach loop – the reason is that they are
only used inside that loop.
After the foreach block executes for all mirrors it's time
to sort the results and present them to the user. We'll
use a special “technique” to sort the results – the
Schwartzian Transform (ST) – a method for sorting a
data structure on an arbitrary key efficiently and with a
minimum amount of Perl code. We map the original list
into a list of references to lists containing the original
and transformed values. The list of references will be
sorted and then mapped back into a plain list containing
the original values. Clear as mud ?
my @transformList = map { [ $_,
(split)[1] ] } @timedList; # transform:
value, sortkey
my @tempSort = sort { $a-»[1] «=» $b»[1] } @transformList;
# sort
my @sortedList = map { $_-»[0] }
@tempSort ;
# restore original
values
Like most Perl syntax, the join, map, sort, and split
functions work right-to-left so we can make that even
shorter:
my @sortedList =
# remember, we
read this right-to-left...
map { $_-»[0] }
# restore

original values
sort { $a-»[1] «=» $b-»[1] }
sort
map { [$_, (split)[1] ] }
@timedList;
# transform: value,
sortkey

#

OK, we're almost there... We print out another
message:
print "\nMirrors speed (time to get 400
KB):\n";
then we print the list with our results:
foreach (@sortedList) {
# loop: for
each element...
print "$_", "s\n";
}
# end of foreach loop
Wait a second... what is that $_ ? That is the Default
Input and Pattern Searching Variable. If you don't
specify a variable to put each element into, $_ is used
instead. We used the above instead something like
foreach my $item (@sortedList) {
loop: for each element...
print "$item", "s\n";
}
# end of foreach loop

#

which would have yielded the same result.
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We also want to tell the user whether there were any
mirrors that for some reason didn't respond:

inside your home), and then you can use it by simply
opening a terminal (from any location) and running

if (@badList) {
# conditional block
print "\nThe following mirrors timed
out or are not valid :\n";
foreach (@badList) {
# loop:
for each element...
print "$_", "\n";
}
# end of foreach loop
}
# end of conditional block

repotest

This is it folks ! You can download the whole script
here:
http://linuxgator.org/forums/viewtopic.php?f=15&t=1719
Or, you can enter the entire script (below), and save it
to your computer. To do that, you should create a new
empty file (document that is). Name it as you wish, let's
say repotest.pl... the extension is not mandatory, but it's
a good habit to use extensions. It gives you an idea on
what that file deals with. You can copy/paste my code
inside, with no problem, as PERL doesn't care much
about indentation. So, it should be pretty
straightforward (you can always consult the one on the
forum if anything goes wrong). When you're done, save
the file and make it executable. You can then open a
terminal in the containing directory and run
./repotest.pl
to see what it does. If you're planning on using it often,
then you should consider removing the extension and
placing the script in your ~/bin (that is, the folder bin

I hope this article opens your appetite for learning
Perl... you will find out that it truly is “the Swiss Army
chainsaw of scripting languages”.
Yours,
Don
The entire script:
#!/usr/bin/perl
use
use
use
use

strict;
warnings;
Time::HiRes qw(gettimeofday);
LWP::UserAgent;

my $testfile =
"pclinuxos/2007/base/srclist.main.bz2";
my @timedList = ();
my @badList = ();
my @reposList = (
"http://ftp.riken.go.jp/pub/Linux
/pclinuxos/apt/",
"http://ftp.kddlabs.co.jp/Linux/p
ackages/pclinuxos/apt/",
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"http://ftp.jaist.ac.jp/pub/Linux
/PCLinuxOS/apt/",
"http://mirror.pclinuxclub.com/pc
linuxos/apt/",
"http://www2.mirror.in.th./osarch
ive/pclinuxos/pclinuxos/apt/",
"http://ftp.twaren.net/Linux/PCLi
nuxOS/apt/",
"http://gnupg.cdpa.nsysu.edu.tw/L
inux/PCLinuxOS/apt/",
"http://mirror.internode.on.net/p
ub/pclinuxos/apt/",
"ftp://mirror.aarnet.edu.au/pub/p
clinuxos/apt/",
"http://na.mirror.garr.it/mirrors
/pclinuxos/apt/",
"http://ftp.ch.debian.org/mirror/
pclinuxos/apt/",
"http://gnustep.ethz.ch/mirror/pc
linuxos/apt/",
"http://debian.ethz.ch/mirror/pcl
inuxos/apt/",
"ftp://ftp.pbone.net/pub/pclinuxo
s/apt/",
"http://ftp.klid.dk/ftp/pclinuxos
/apt/",
"http://mirrors.lastdot.org:1280/
pclos/apt/",
"http://mirrors.xservers.ro/pclin
uxos/apt/",
"http://ftp.heanet.ie/pub/pclinux
os/apt/",
"http://ftp.belnet.be/mirror/pcli
nuxonline.com/apt/",

"http://ftp.nl.freebsd.org/os/Lin
ux/distr/texstar/pclinuxos/apt/",
"http://ftp.sh.cvut.cz/MIRRORS/pc
linuxos/apt/",
"ftp://cesium.di.uminho.pt/pub/pc
linuxos/apt/",
"http://distribcoffee.ipsl.jussieu.fr/pub/linux/pclinuxo
s/apt/",
"http://ftp.cc.uoc.gr/mirrors/lin
ux/pclinuxos/apt/",
"http://ftp.leg.uct.ac.za/pub/lin
ux/pclinuxos/apt/",
"http://spout.ussg.indiana.edu/li
nux/pclinuxos/pclinuxos/apt/",
"http://ftp.uwsg.indiana.edu/linu
x/pclinuxos/pclinuxos/apt/",
"http://ftp.ussg.iu.edu/linux/pcl
inuxos/pclinuxos/apt/",
"http://pclosusers.com/pclosfiles
/",
"http://distro.ibiblio.org/pub/li
nux/distributions/texstar/pclinuxos/apt/"
);
print "Downloading srclist.main.bz2
from each mirror...\n";
foreach my $url (@reposList) {
my $link = "$url$testfile";
my $ua = LWP::UserAgent-»new();
$ua-»timeout(3);
$ua-»show_progress('TRUE');
my $t0 = gettimeofday();
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my $response = $ua-»get($link);
my $t1 = gettimeofday();
$url =~
s|(\w+://.*?)(:\d+)?/(.*)|$1|;
if ($response-»is_success) {
my $delta = ($t1 - $t0);
my $line = $url.' '.$delta;
push(@timedList, $line);
}
else {
push(@badList, $url);
}
}
my @sortedList =
map { $_-»[0] }
sort { $a-»[1] «=» $b-»[1] }
map { [$_, (split)[1] ] }
@timedList;
print "\nMirrors speed (time to get
400 KB):\n";
foreach (@sortedList) {
print "$_", "s\n";
}
if (@badList) {
print "\nThe following mirrors
timed out or are not valid :\n";
foreach (@badList) {
print "$_", "\n";
}
}

Visit
Visit Us
Us On
On IRC
IRC
• Launch your favorite IRC Chat Client software
(xchat, pidgin, kopete, etc.)
• Go to freenode.net
• Type "/join #pclinuxos-mag" (without the quotes)
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Video File Format Comparison
by Paul Arnote
In my series of articles comparing various file formats
(July, 2009: Graphic File Format Comparison, August,
2009: Audio File Format Comparison), I turn my
attention to video file formats. Although we commonly
call them video file formats, they are really containers
for combining separate video and audio information into
a synchronized data stream.
In my previous two articles, we talked about graphic
and audio formats being either lossy or lossless in their
compression. Because video files are so large, it is not
common or practical to use uncompressed video. Thus,
nearly all of the video formats use some type of
compression, and for the most part, all of those
compression techniques are considered lossy.
Before we can talk about the various video file formats,
there are a few terms we need to become familiar with.
Mind you that entire chapters of books have been
written to explain these terms and formats. In this
medium, I'm going to try to give the most simplified
explanation as I can, mostly because we don't need to
know all the intricacies involved to understand what
they mean.
The first of these is bitrates. Bitrates refer to how many
bits per second are used to represent the video portion
of the file. These can vary from as low as 300 kbps
(kilobits per second) for low quality video, to as high as
8,000 kbps for very high quality video. Just as with
sound files, a higher bitrate translates to a better quality
video.

The next thing we need to discuss is how the image
appears. We have two terms to describe the video
image: interlaced and progressive. Interlaced video is a
way to make the best use of the limited bandwidth for
transmitting video, especially in the older days of
analog NTSC broadcasts. The receiver (your TV)
"tricks" your eyes by drawing first the odd number lines
on the screen 30 times per second (25 times per
second in Europe), and alternating the drawing of the
even numbered lines on the screen 30 times per
second, in an odd — even — odd — even — odd —
even pattern. Progressive video draws both the odd
and even numbered lines at the same time, instead of
alternating them. This makes the picture appear
sharper and more vivid.
Next, is resolution. In the analog video days, video was
commonly the equivalent of 352 x 240 pixels for NTSC
video in North American, and 352 x 288 for
PAL/SECAM video elsewhere. Today's digital
televisions can display up to 1920 x 1200 pixel pictures.
Computer monitors have much higher display
resolution than conventional analog televisions. The
move to digital televisions has made it feasible to multitask the family television to double as a large computer
monitor. A common resolution for DVD quality video is
720 x 480 for NTSC, and 720 x 576 for PAL/SECAM
systems. The resolution for the new high definition
television broadcasts are even higher, and provide BluRay quality, able to display a pixel-for-pixel
representation of the highest High Definition television
specification at 1920 x 1200 pixels.
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Formats, or Containers
Theora
We start with the Theora container, because it is open
source. And, because this is a Linux publication, we are
particularly fond of open source solutions. Developed
by the Xiph.Org Foundation as part of the OGG project,
it is derived from On2 Technologies' VP3 video codec.
It's also named after Theora Jones, Edwin Carter's
Controller on the old Max Headroom television show.
Because it is developed and maintained by the
Xiph.Org Foundation, it commonly has Vorbis formatted
audio streams, placed into an OGG container. Since
On2 Technology released the VP3 codec and its source
code to the public under an open source and free
software license, and disclaimed any rights and patents
on the technology in September 2001, it allowed
anyone to use Theora and other VP3-derived codecs
for any purpose. In 2002, On2 inked an agreement with
the Xiph.Org Foundation to make VP3 the basis of a
new and free Theora video codec, and declared Theora
to be the successor to VP3.
The first stable v1.0 release of Theora was in
November 2008. Since it is a relatively new format that
has very little commercial support, Theora has
struggled to gain acceptance from distributors,
especially on the web. Yet, as the only mature and
royalty free video codec, Theora is well established as
a baseline video format in modern free software, and
has become the format of choice for many other
organizations (e.g., Wikipedia).

Theora does not make use of hardware acceleration,
but because its algorithm is less complex than H.264,
which is used by the competing MP4 format, the need
for hardware acceleration is not considered to be as
relevant.
There are several applications in the PCLinuxOS
repository that can play, stream and edit Theora video
files. For encoding, VLC and HandBrake are available.
Cinelarra can edit Theora video files, while VLC can
stream them.
MPEG-1
While development of the MPEG-1 standard began in
1988, it wasn't until 1992 that the final standard was
approved and the first MPEG-1 decoder was made
available. Compressing video 26:1 and audio 6:1, the
MPEG-1 format is designed to compress VHS quality
raw digital video and CD audio with a minimum of
quality loss.
Today, it is the most widely compatible lossy
compression format in the world. MPEG-1 standard is
part of the same standard that gives us the MP3 audio
format. Fortunately, the MPEG-1 video and Layer I/II
audio can be used royalty free and without license fees,
since the patents expired in 2003. Only the MPEG-1
Layer 3 Audio format (more commonly known as MP3)
is still covered by patents and licensing restrictions.
The “standard” MPEG-1 video bitrate is 1,150 kbps,
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with audio at 224 kbps and 44.1 kHz sample rate. The
video is recorded at 352 x 240 pixel screen size for
NTSC, and 352 x 288 pixel screen size for PAL/SECAM
systems. One distribution format that makes wide use
of the MPEG-1 format is the Video Compact Disc, or
VCD. Although it never caught on in the U.S., other
parts of the world have seen wide adoption of the VCD,
due to its relatively inexpensive production costs,
coupled with the VCD's ability to withstand high
humidity environments (as present in Southeast Asia)
better than VHS tape.
MPEG-1 formatted video files are easily read by most
of the video programs in the PCLinuxOS repository.
MPEG-2
The MPEG-2 format was born from the shortcomings of
the MPEG-1 format. Specifically, the MPEG-1 format
had less efficient audio compression, a lack of flexibility
when it came to the packet types it accepted, and it
does not support interlaced video. MPEG-2 is also the
format of choice for digital televison broadcasts.
Work on the MPEG-2 format began in July, 1990 –
before the first draft of MPEG-1 was ever written. It was
intended to extend the MPEG-1 format to provide full
broadcast quality video at high bitrates, between 3 – 5
Mbits/s, and added support for interlaced video.
MPEG-2 is the designated format for movies and other
programs that are distributed on DVD, SuperVCD, and
BluRay discs. As a result, the televisions in our living
rooms, along with the TV broadcast stations and our

DVD players are designed to the MPEG-2 standard.
Because MPEG-2 evolved from the MPEG-1 format, all
standards compliant MPEG-2 decoders can also play
MPEG-1 video streams. Thus, even though you may
not realize it, you can play VCDs in most home DVD
players.
Currently, over 640 patents, owned by more than 20
corporations and one university, and the patent pool
managed by the MPEG Licensing Authority, burden the
MPEG-2 format. In jurisdictions where software patents
are upheld and enforced (currently, the U.S. is included
in those jurisdictions), use of the MPEG-2 format
requires payment of licensing fees to the patent
owners. It“s best to check the laws of your jurisdiction,
since they vary so widely. For example, software
patents are not allowed in India and the Philippines, but
they are in Japan and Korea, and to a limited extent, in
Europe and Australia. Hence, this is one of the reasons
that PCLinuxOS does not come with DVD playback
software enabled by default; rather the end user must
install the necessary libraries and dependencies
themselves, based on the laws of their relevant
jurisdiction.
MPEG-4
MPEG-4 represents a patented collection of methods to
define compression of video and audio, designating a
standard for a group of audio and video codecs. MPEG4 encompasses many of the features of MPEG-1 and
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MPEG-2, while adding support for 3-D rendering,
Digital Rights Management (DRM), and various types
of interactivity.
MPEG-4 files are commonly encoded with codecs like
DivX, Xvid, 3ivx, and x264 to name a few, and may be
used by BluRay discs. Since most of the features of the
MPEG-4 standard are left to the discretion of the
individual developers to implement, they are free to
choose which parts of the MPEG-4 format to
implement. Thus, a “full implementation” of the MPEG-4
format does not exist, and most likely will never exist.
Introduced in late 1998, more than two dozen
companies claim ownership of patents related to MPEG4. The licenses for use of the MPEG-4 format (in
jurisdictions where software patents are upheld and
enforced) is handled by the MPEG Licensing Authority.
MPEG-4 files can usually be easily viewed on
PCLinuxOS, using VLC or MPlayer.
QuickTime
Initially released in December, 1991, the QuickTime
format is released under a proprietary license from
Apple, beating Microsoft’s Video for Windows to the
“market” by nearly a full year. Developed as a
multimedia framework by Apple, Inc., it is capable of
handling various formats of digital video, media clips,
sound, text, animation, music, and interactive
panoramic images. The most current stable release is
QuckTime 7.6.2, and is available for Mac operating
systems, and computers running Windows. Although no

formal implementation exists for Linux, there are a
number of programs in Linux which can handle (with
varying degrees of success), QuickTime video
playback. Possibly the best of the Linux programs that
can handle playback of most QuickTime files are VLC
and MPlayer, both of which are in the PCLinuxOS
repository.
In February, 1998 the International Standards
Organization approved the QuickTime file format as the
basis of the MPEG-4 file format. The benefit is that
MOV and MP4 files (containers) are interchangeable on
a QuickTime-only environment (meaning running in an
“official” QuickTime player, like QuickTime on the Mac
OS X or QuickTime for Windows), since both use the
same MPEG-4 codecs.
AVI
AVI, more formally known as Audio Video Interleave,
was released in November, 1992 by Microsoft as a part
of its Video for Windows technology. It is basically a file
container the allows synchronized audio and video
playback.
Since AVI files do not contain pixel aspect ration
information, and many players render AVI files with
square pixels, the frame (image) may appear stretched
or squeezed horizontally when played back. However,
VLC and MPlayer have solved most problems related
to the playback of AVI files.
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Although being “older” technology, there is a benefit to
using AVI files. Because of it being around for so long,
coupled with Microsoft’s market penetration, AVI files
can frequently be played back on the widest variety of
systems and software, second only to MPEG-1. It has
gained widespread acceptance and adoption
throughout the computer industry, and can be
successfully played back, so long as the end user has
the proper codec installed to decode the video properly.
Additionally, the AVI format is well documented, not only
from Microsoft, but also many, many third parties.

distributing high definition content from HDTV and
BluRay discs.

Matroska

The WMV files are often wrapped in the ASF, or
Advanced Systems Format. WMV files, themselves, are
not encoded. Rather, the ASF wrapper is often
responsible for providing the support for digital rights
management, or DRM. Based on Windows Media 9,
WMV files can also be placed inside either an AVI or
Matroska container. In that case, the WMV file claims
either the AVI or MKV file extensions.

Matroska files, commonly recognized by either their
*.mkv file extension, represent a multimedia container
that is an open standard free container format. It can
hold an unlimited number of video, audio, picture, or
subtitle tracks in a single file. Implementations of the
Matroska format consists mostly of open source
software.
The word, matroska, is an English word derived from
the Russian word matroyshka, the name for the nesting
doll, where one egg-shaped doll is found inside
another, then another, and so on.
Matroska video files (*.mkv) can be played back on a
wide variety of software in PCLinuxOS, including
MPlayer, VLC, Avidemux, and MythTV. And, because
Matroska is an open standards project, much like
Theora, the source code of the libraries are developed
under the GNU LGPL. It has gained popularity recently,
especially among the warez crowd for ripping and

WMV
WMV, or Windows Media Video, is a compressed video
file format, made with several different proprietary
codecs, made by Microsoft. Originally intended to
compete with RealVideo in 2003 as an alternative for
streaming video, it has since gained adoption for use
with BluRay discs.

WMV files can be played on PCLinuxOS, using VLC,
MPlayer, or most any other program that uses the
FFmpeg implementation of the WMV codecs.
3GP
The 3GP format is actually two similar formats. The
first, 3GPP, is designed as a container format for GSM
phones (in the U.S., primary GSM wireless carriers are
AT&T and T-Mobile). The second, 3GPP2, is designed
as a container format for CDMA phones (in the U.S.,
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primary CDMA wireless carriers are Verizon and
Sprint). 3GPP files will often carry a 3GP file extension,
while 3GPP2 files will often carry a 3G2 file extension.
3GP and 3G2 files store video streams using MPEG-4
Part 2, H.263, or AVC/H.264 codecs. Some cell phones
will use the MP4 file extension to represent 3GP video.
Both formats were designed to decrease storage and
bandwidth requirements to accommodate mobile
phones.
Software support under PCLinuxOS is, once again,
achieved with VLC and MPlayer. Additionally, 3GP files
(and most 3G2 files) can be encoded and decoded with
FFmpeg.
FLV
FLV files, also known as Flash Video, are a file
container format used primarily to deliver video over the
Internet. In fact, it has become the defacto format of
choice for such sites as YouTube, Google Video,
Yahoo! Video, Metacafe, and many news outlets.
While the FLV format is an open format, the codecs
used to produce FLV files are mostly patented. The
most common codecs used are the Sorenson Spark
(H.263 codec variant) and On2’s VP6. FLV files can
also be encoded as H.264 in the more recent releases
of Adobe Flash.
Most audio in an FLV file is recorded as MP3, although
there are a few proprietary audio codecs used.
Uncompressed ADPCM (Audio-Digital Pulse Code

Modulation) can also be used to record audio in an FLV
file. More recent versions (from Flash 9, upwards) also
support the recording of audio in the AAC (Advanced
Audio Coding) format.
Under PCLinuxOS, VLC and MPlayer support playback
of FLV files. One can also encode FLV files with
FFmpeg. Additionally, it’s usually a simple matter, using
Avidemux, to convert from the FLV format to another,
more universally read format – such as AVI or MPEG-1.
You can also use Avidemux to edit FLV files.
And by the way – changing the file extension from FLV
to AVI does not make it an AVI file. Rather, it’s just an
FLV file with an AVI file extension. Simply changing the
file extension does nothing to the file header in the
video file, which is what determines they type of video
file it really is. I point this out because of a post in the
forum some time ago (perhaps a year ago?) that made
this erroneous assertion. The poster achieved the
results they did merely because the system knew how
to handle a file with the AVI file extension, by playing it
in VLC or MPlayer. In actuality, the programs are
playing the FLV file, not an AVI file – something they
already have the capability to do.
Summary
I hope this helps alleviate any confusion you might
have had regarding video file formats. Plus, having a
basic understanding of the various video file formats is

67

Video File Format Comparison
helpful when trying to figure out how to convert from
one format to another. While this isn’t meant as a
comprehensive overview or discussion of the subject
matter – entire books have been written, trying to cover
the topic – it should be enough to get you at least
started in the right direction. And, there are many more
file formats out there that I didn’t talk about. Rather, I
hand-picked some of the more common ones that you
are likely to find or have a need to “work with.”

Would
Would You
You Like
Like To
To Help?
Help?
Would you like to help with the PCLinuxOS
Magazine? Opportunities abound. So get involved!
You can write articles, help edit articles, serve as a
"technical advisor" to insure articles are correct,
create artwork, or help with the magazine's layout.
Join us on our Google Group mailing list.
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In the Mood for PCLOS

OGG

MP3

ms_meme's
ms_meme's nook
nook

Who's the crazy Texan well he's one of those guys
Made a new OS and it's no surprise
I'll just ask him baby won't you show it to me
Hope he tells me maybe he's THE MAN you see

I went to the forum just to tell 'em my news
All of my info to them infuse
They said baby if you tell us the scoop
We'll just maybe let you into the loop

So I said to Tex I don't mean to be rude
He said don't keep me waitin'
When I'm in the mood

I said I don't mean to intrude
They said don't keep us waiting
When we're in the mood

First I saw the code just a wee little glance
Then we went to safe mode I was in his trance
I said Tex won't you show me some more
He said baby you're a bit of a bore

Tex has made this neat little box
Everything about it well it really rocks
They said baby won't you tell us some more
It's everything you're a looking for

I said Tex I'm not a prude
Don't keep me waitin'
When I'm in the mood

Tex really is one cool dude
Let's go get it
While we're in the mood

In the mood for his scriptin'
In the mood for his encriptin'
In the mood my heart's a flippin'
It didn't take me long to say I'm in the mood now

In the mood for his down loadin'
In the mood for his crazy codin'
In the mood our hearts are explodin'
It didn't take us long to say we're in the mood now

In the mood for PCLOS
In the mood it really is the best
In the mood what a great success
It didn't take me long to say I'm in the mood now

In the mood for PCLOS
In the mood it really is the best
In the mood what a great success
It didn't take us long to say we're in the mood now
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Movie Archiving With dvd::rip
by Malcolm Ripley (malc)
Why would you want to archive your movies? Well in
my case, it was space and convenience. Far too many
CD's and DVD's to have easily accessible on shelving -literally a room full! A 1TB USB disk drive costs under
£70 ($100) and could easily accommodate all my
music, movies and photos. In addition it can be plugged
into the PS3, which is itself plugged into an AV receiver,
and from there into a hi-def TV. A perfect, simple
solution. As an added bonus, a PSP can be used as a
remote control for music so that the TV does not have
to be switched on.
In the past, I had compressed some movies for my kids
to play on their PSP's, and I did this using a PC. Back
then, I had ripped and converted the movies to about
200MB/hour prior to PSP conversion (it has it's own
MP4 format!). The full size were just about watchable
but dark areas were quite low quality. At 300MB/hour
the movie is passable although dark areas are still
“blocky” even on a TV at distance. At 400MB/hour the
movie was indistinguishable from the original (on a TV).
Not only that, but with the PS3 1080p upscaling, the
quality was suprisingly very good. So there we have it -400MB/hour was the target.

You will need several GBs of space to proceed, enough
to accommodate a ripped and compressed movie. A
ripped movie can, in theory, take up almost 8GB plus
the compressed version of 1.5GB. So you need at
least 10GB.
Take note that, at present, only movies without subtitles
can be be encoded. This is under investigation.
Getting Started
When you first start dvd::rip, you will be presented with,
essentially, a blank screen. There is no need to set any
preferences at this point, since the defaults are OK. To

Preparation
You need to download and install dvd::rip using
Synaptic. The download will include the DVD decrypting
library libdvdcss2, if you have not already done so.
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get started, select File » New Project and the previous
screen will be displayed.
Enter the project name (default unnamed), which
cannot include any spaces, and then press Create
project. The screen will now look as above, and it
should be showing the correct DVD device as the data
source. If you do need to change the setting and enter
by hand (/dev/hdc in the example), then you can
identify this for your machine by putting in a DVD,
select Properties for the desktop icon and click Meta
Info. The device node is the value you want.
Ensure Copy data from DVD... option is selected and
press the tab labelled Rip Title, which takes you to the
following screen:

Initially, the contents area will be blank. Click on the
button Read DVD Table of Contents, the disk will be
scanned with all the titles listed and the main one auto
selected. Most DVD's have the first audio track in
English. However, if you have any doubts, then perform
a check as following:
1. Click the Selection option under Specify Chapter
Mode and select any chapter except the first or last
(these almost always have the titles).
2. Check each audio track to find the one you want by
reviewing with View selected title/chapter and take a
note for the transcode step.
3. Re-select the None option.
Now you can rip the title to your hard drive
by pressing the button RIP Selected
Titles(s)/Chapter(s). This will take a while.
Ripping a 2 hour movie with my 1.8G dual
core laptop takes 20 minutes. You can
always flip to another desktop screen and
do something else, which will slow the
ripping down a little. Once the title has
been ripped, select the Clip & Zoom tab
where you will be presented with the
following:
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Use the preset value Autoadjust, Big Frame Size, HQ
Resize and click the Apply preset values button.
However, if the movie is full frame (ie TV format ) I
suggest using the Fast resize version. This creates a

smaller framed movie. A full frame is 50% larger
(including the final file size) than a widescreen movie.
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Now select the tab transcode and the following screen
will be displayed:

Don't panic! Almost all these setting are default values
and don't need changing. The key values are Video
codec: xvid, 2-pass encoding: yes, and no
deinterlacing. Ensure the audio track is the one you
chose when ripping and that Bit-/Samplerate: 128k/s
48000hz, Quality: 2, Filter: None, and Volume Rescale
only.

Some movies do not compress properly and end up
with an out of synch audio track. The way round this is
to miss out the first few frames. This is not normally an
issue since most movies start
with a studio banner and then
the opening titles so skipping
the first 10 seconds is not a
problem. To save time (a lot
of time!) apply this fix to all
movies by default. You can
do this under General options
and set the Frame range
(start) to 250 (300 in North
America, due to the
NTSC/ATSC frame rate of
29.97 frames per second, as
opposed to the PAL standard
of 25 frames per second) and
leave the end of the range
blank. This will clip 10
seconds from the start and so
far, for myself, all movies are
now in synch.
Some movies can be a little
over dark (Alien v Predator
Requiem for example). You
can, optionally, lighten it up by specifying a filter under
Configure filters & Preview :
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set, close the window to
return to the transcode
screen.
Finally now, we're to the
transcoding step. Select
Video Bitrate calculation » By
Quality » 0.15 and then press
Transcode. The transcode
process takes hours. The
second pass typically takes
twice as long as the first.

Double click the levels filter from the top left list. Click
and drag it on the top right list so that it is between PRE
and POST. Set the gamma value in the bottom right to
something larger than 1. Typically 1.5 to 2 will suffice.
You can preview the effect using the preview controls.
You can only perform a preview with the original disk
not from the ripped titles. Should you attempt to
preview without the disk inserted, you will get an error
and dvd::rip gets a little confused; the error won't go
away, even when you put the disk in. You have to save
the project, quit dvd::rip and reload. Once the filter is

You may be tempted to
perform a single pass
encoding to save time, but
you do so at the expense of
quality. There is a distinct
difference between single
and two pass encoded
movies. Single pass movies
seem to shimmer around
image edges, such as the
outlines of faces, buildings
etc. There is nothing to stop you transcoding while you
work though. I have even done photo editing while a
movie is transcoding.
Note: If you transcode overnight then you can start two
dvd::rip sessions in parallel.
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Potential Problems
When ripping a title, it can sometimes hang before it
reaches the end. The movie can still be compressed,
but proceed as follows:
1. With Konqueror, open up the folder «home»/dvdripdata/«projectname»/vob/xxx/ and play the last vob file.
Fast forward to the end if necessary to confirm that the
end of the movie is there before proceeding with this
workaround. So far this problem has only omitted the
last small (often zero sized) vob file that contains only
credits.
2. Save the project, quit and re-open.
3. On the Rip title screen, select the smallest chapter
(except the first or last) and rip that.

5. Go back to the Rip title screen, set the chapter mode
to None and
6. Go to the Transcode screen and proceed as
previously described.
Summary
Once you get into the swing of things, it is suprisingly
easy. Since it is possible to transcode “off-screen,”
then 3 to 6 movies can be transcoded per day without
interfering with normal usage.
Subtitles are a problem yet to be resolved. There are
plenty of descriptions of how to do it, but none are trivial
tasks, to put it mildly. Should I discover a simple “point
and click” method, I'll let you all know.

4. Go to the Clip & Zoom screen and set the clipping as
described previously. Here you are using the ripped
chapter to assess the size.
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A Cheap Film Scanner
by Malcolm Ripley (malc)

Try this method:

A cheap scanner for archiving old snapshots for on
screen viewing was desperately needed sooooo.....

1. Place a piece of white paper where the sun can
illuminate it. This creates a very bright, even light
source. I did this at my French windows.

I caught a YouTube video where somebody created a
"scanner" from a lamp, paper, digital SLR etc.

2. Place two equal height supports either side. Make
sure the supports do not
reflect any light nor shade
the paper.
3. Get hold of a film
scanner negative holder (I
had one from a very old
SCSI scanner, now
unusable) and place this on
top of the supports.
4. Get a box which is large
enough to envelop your
camera to make into a
tube. Ideally, the length of
this tube should match the
minimum focus distance of
your camera.

However, this method creates a few problems,
especially with transmitted light through the paper for a
diffused light source, which highlights the grain of the
paper. Also the glass used to hold the negatives
highlights any dust.

5. Place the tube on top of
the negative holder with the
image to be scanned off
center (I'm assuming most SLR's have the lens off
center like mine). The off center placing is necessary to
avoid distortion as you automatically tend to center the
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camera at the edge of the tube, especially when your
hands are in contact with the edges.

Despite not having a macro lens on my 6Mb SLR I can
get a decent 1.5Mb image using this method.

6. Photograph the negative.

It's FAST ...... VERY FAST! It takes less than 5 minutes
to scan a 24 image reel of film. You can then do all the
GIMP stuff when the sun sets, with a glass of red wine
to help ;-)

7. Load the picture into Gimp and:
a) Use Tools » Transform Tools » Rotate , to align the
image. You can use the edge of the rotate dialog to get
this done accurately.

Now, just a note about camera settings. The pictures
must be clear so the usual settings are needed,

b) Use the rectangle
select tool to select the
negative area.
c) Edit » Cut
d) Edit » Paste as new
image
e) Optionally rotate for
landscape/portrait etc with
the quick option: Image »
Transform
f) Colors » Invert
g) Colors » Auto » White
Balance
h) Optionally colors »
color balance. My images
tend to be a little blue/cyan so I increase the red and
yellow hues.
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namely: as low an ISO setting as possible, and a
minimum shutter speed of 1/125 (unless you use a
tripod). I set my camera for programmed mode with a
fixed ISO of 200. This worked fine, even when the sun
went behind the inevitable Scottish clouds!

The above photo is an example of a negative scanned
using the above methods, from a vacation to Crete in
1992.

Further experimentation indicates that the best pictures
are obtained by setting the camera to Raw format and
using the Gimp Raw converter. This is a Gimp plug in
that is in Synaptic. Using raw images I do the following:

Malcolm

Regards,

1. Rotate landscape format so the edges are square.
2. Cut and paste new image.
3. Rotate to portrait if necessary.
4. Colors - Invert.
5. Colors - Levels, and adjust the range on each
channel to encompass the main distribution.
Sometimes there is the odd values outside the main
distribution.
6. Still with the levels, adjust the center slider on
whichever channel has a color cast to remove that cast.
In my case I usually have to adjust the blue channel
from 1.0 to 0.9.
7. Filters - Enhance - Sharpen, with a value of between
40-45.
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Disclaimer
1.

All the contents of the NEW PCLinuxOS Magazine are only for general information and/or use. Such contents
do not constitute advice and should not be relied upon in making (or refraining from making) any decision. Any
specific advice or replies to queries in any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by the NEW PCLinuxOS Magazine.

2.

The information in the NEW PCLinuxOS Magazine is provided on an "AS IS" basis, and all warranties,
expressed or implied of any kind, regarding any matter pertaining to any information, advice or replies are
disclaimed and excluded.

3.

The NEW PCLinuxOS Magazine and its associates shall not be liable, at any time, for damages (including, but
not limited to, without limitation, damages of any kind) arising in contract, rot or otherwise, from the use of or
inability to use the magazine, or any of its contents, or from any action taken (or refrained from being taken) as
a result of using the magazine or any such contents or for any failure of performance, error, omission,
interruption, deletion, defect, delay in operation or transmission, computer virus, communications line failure,
theft or destruction or unauthorized access to, alteration of, or use of information contained on the magazine.

4.

No representations, warranties or guarantees whatsoever are made as to the accuracy, adequacy, reliability,
completeness, suitability, or applicability of the information to a particular situation.

5.

Certain links on the magazine lead to resources located on servers maintained by third parties over whom the
NEW PCLinuxOS Magazine has no control or connection, business or otherwise. These sites are external to
the NEW PCLinuxOS Magazine and by visiting these, you are doing so of your own accord and assume all
responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by users. The NEW PCLinuxOS Magazine
accepts no responsibility for the content, accuracy, conformity to applicable laws of such material.
Entire Agreement
These terms constitute the entire agreement between the parties with respect to the subject matter hereof and
supersedes and replaces all prior or contemporaneous understandings or agreements, written or oral, regarding
such subject matter.
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